Welcome to NX 11

July 2016

Dear Customer:

We are proud to introduce NX 11, the latest release of our NX product development solution. NX 11 is a major release with significant new functionality in all areas of the product and we believe that the new and enhanced functions will help you become more productive.

Siemens PLM Software has a clear and consistent strategy: to provide Digital Product Development and Manufacturing solutions that help you transform your whole product development process. This release delivers enhancements that enable you to increase your levels of productivity in product development and manufacturing while working within a collaborative managed environment.

With the NX 11 release, we continue to look for innovative ways to deliver solutions that meet your product development and manufacturing challenges.

We are confident that our accomplishment of these objectives will enable you to extract the highest value from our solutions. For a complete overview of all enhancements and for additional information about this release, refer to the What’s New Guide included with the NX 11 Help.

Help now available on the web

Help is now available on the web. You can access the Help from within the software and from the Windows Start menu.

If you prefer to access a local version of the Help, you can do one of the following:

• Install the Siemens PLM Documentation Server and documentation. This sets up a local web server on users’ workstations.

• Install the documentation into an existing company-wide server.

The Help now requires a web server. For more information on the installation, see the splmdocserver_install and webserver_install guides for Windows and UNIX.

Sincerely,

Your NX 11 Team
Contents

Welcome to NX 11 ................................................................. 2

System Information ........................................................................ 1-1

Customer support ........................................................................ 1-2
Version up testing .......................................................................... 1-3
Platforms ...................................................................................... 1-3
  NX central runtime directory ...................................................... 1-3
  System requirements guidelines .................................................. 1-5
  Operating system requirements ................................................... 1-7
  Mac OS X Support ....................................................................... 1-11
  Supported hardware and graphics ................................................. 1-15
  Named user NX licensing ........................................................... 1-16
  Linux graphics caveats ............................................................... 1-17
  Initializing the JVM ...................................................................... 1-18
  NX variables in the ugli_env.dat file ............................................ 1-19

Browser requirements .................................................................... 1-21
  Browser and plug-in requirements ............................................... 1-21
  Browser caveats ......................................................................... 1-23

Licensing Caveats ......................................................................... 1-24
  General licensing caveats .......................................................... 1-24
  Licensing caveats for Windows .................................................. 1-25
  Licensing caveats for Linux ....................................................... 1-26
  Licensing caveats for Mac OS X ................................................ 1-27

Product compatibility - supported version combinations ............. 1-29
NX compatibility with Spreadsheet ................................................. 1-31
NX applications unsupported on specific platforms ..................... 1-32
Support for touch enabled devices ................................................ 1-33

Teamcenter Integration for NX ....................................................... 2-1

Product Notes .............................................................................. 2-2
Caveats ......................................................................................... 2-4

Fundamentals .............................................................................. 3-1

Product Notes .............................................................................. 3-2
Caveats ......................................................................................... 3-3

Customer Defaults ....................................................................... 4-1

Customer defaults ........................................................................ 4-2

CAD .......................................................................................... 5-1

Modeling ..................................................................................... 5-1
<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Product Notes</strong></td>
</tr>
<tr>
<td><strong>Caveats</strong></td>
</tr>
<tr>
<td><strong>Drafting</strong></td>
</tr>
<tr>
<td><strong>Product Notes</strong></td>
</tr>
<tr>
<td><strong>Assemblies</strong></td>
</tr>
<tr>
<td><strong>Caveats</strong></td>
</tr>
<tr>
<td><strong>Data Reuse</strong></td>
</tr>
<tr>
<td><strong>Caveats</strong></td>
</tr>
<tr>
<td><strong>Sheet Metal</strong></td>
</tr>
<tr>
<td><strong>Caveats</strong></td>
</tr>
<tr>
<td><strong>Routing</strong></td>
</tr>
<tr>
<td><strong>Caveats</strong></td>
</tr>
<tr>
<td><strong>Documentation Notes</strong></td>
</tr>
<tr>
<td><strong>Product Notes</strong></td>
</tr>
<tr>
<td><strong>Ship Structure</strong></td>
</tr>
<tr>
<td><strong>Caveats</strong></td>
</tr>
<tr>
<td><strong>Product and Manufacturing Information (PMI)</strong></td>
</tr>
<tr>
<td><strong>Documentation notes</strong></td>
</tr>
<tr>
<td><strong>PCB Exchange</strong></td>
</tr>
<tr>
<td><strong>Caveats</strong></td>
</tr>
</tbody>
</table>

**CAM** .............................................. 6-1

**Manufacturing Product Notes** .............................................. 6-1
**Manufacturing Product Notes** .............................................. 6-1
**CAM Early Adopter program** .............................................. 6-2
**Tool path and template changes** .............................................. 6-3
**General changes** .............................................. 6-4
**Integrated Simulation and Verification (ISV)** .............................................. 6-6
**Turning** .............................................. 6-10
**Hole machining** .............................................. 6-11
**Feature-based Machining (FBM)** .............................................. 6-12
**Manufacturing critical maintenance and retirement notices** .............................................. 6-13

**Manufacturing caveats** .............................................. 6-15
**General caveats** .............................................. 6-15
**Milling caveats** .............................................. 6-17
**Hole machining caveats** .............................................. 6-19
**ISV caveats** .............................................. 6-20
**Post Configurator** .............................................. 6-22
**Feature based machining caveats** .............................................. 6-23

**Simcenter (CAE)** .............................................. 7-1

**New Simcenter application names and product** .............................................. 7-2
**Pre/Post** .............................................. 7-2
**Caveats** .............................................. 7-2
**Motion** .............................................. 7-6
**Caveats** .............................................. 7-6
**Documentation notes** .............................................. 7-9

**Design Simulation** .............................................. 8-1
Caveats ........................................................................................................ 8-2

**Inspection and validation** ......................................................................... 9-1
Check-Mate and Requirements Validation ................................................... 9-1
  Caveats ........................................................................................................ 9-1
CMM Inspection Programming ...................................................................... 9-1
  CMM release notes ....................................................................................... 9-1
  Caveats ........................................................................................................ 9-2

**Tooling Design** .......................................................................................... 10-1
Weld Assistant ............................................................................................... 10-1
  Documentation notes ................................................................................... 10-1

**Data translation** ........................................................................................ 11-1
Product Notes .................................................................................................. 11-2
  Caveats ........................................................................................................ 11-3

**4th Generation Design** ............................................................................ 12-1
Product Notes .................................................................................................. 12-2

**Mechatronics Concept Designer** ............................................................... 13-1
Product Notes .................................................................................................. 13-2

**Line Designer** ........................................................................................... 14-1
Product notes ................................................................................................... 14-2
  Documentation notes ..................................................................................... 14-4
  Caveats ........................................................................................................ 14-5

**Programming Tools** .................................................................................. 15-1
Chapter 1:  System Information


## Customer support

Customers covered by valid maintenance agreements are eligible to receive telephone and web support from the Global Technical Access Center (GTAC) on issues regarding any current or past release. If you are a customer of one of our partners or resellers, you should contact them first to determine who is your first line support provider. If your first line of support is provided by one of our partners, they will contact us on your behalf if needed to respond to your issue.

To report serious problems against supported releases, please contact your local GTAC support center. You can find your local support center, contact phone numbers and additional information on GTAC support and available services by visiting our GTAC page at http://www.siemens.com/gtac

We will always assist our customers to the best of our ability.
**Version up testing**

Version up testing helps you to ensure that your existing data will version up smoothly to the latest release of NX. We provide an automated application that checks part features, drawings, and smart model data to make sure that they are compatible with the latest release of NX. You can use this application to test a large collection of data with minimum intervention. You can submit parts with detected problems for further evaluation by Siemens PLM Software by submitting problem reports through normal GTAC processes.

If you are interested in version up testing, refer to the following directories for the appropriate README files and associated utilities.

For feature modeling: `.../ugsamples/update_all_features`
For drawings: `.../ugsamples/TrackDrawingChanges`

**Platforms**

**NX central runtime directory**

**Central runtime directory concept**

Starting in NX 11, to help you find executables and libraries, and distinguish them from configuration files more easily, a central runtime directory that contains DLLs, executables, and JAR files is used. The central runtime directory will be updated as NX supports more and different applications.

Scripts that are used to wrap executables have not been moved and they are still in their original kit locations with the configuration files.

**NXBIN directory**

The central runtime directory, NXBIN, is created on all platforms at the `UGII_BASE_DIR\nxbin` location during the NX installation. Depending on what was selected to be installed, libraries and executables from different kits are consolidated into the central runtime directory during the install process.

The new NX runtime directory does not contain all binaries and executables. Only the most frequently used files from the following directories have been moved:

- UGII
- UGMANAGER
- STEP203UG
- STEP214UG
- PVTRANS
- MACH

Other files will also be moved over time. However, some applications, such as NX Nastran, will not be moved.
While NXBIN does not contain all of the executables and DLL’s, it does contain a large quantity and is a prime location to search for an executable or library.

**UGII_ROOT_DIR obsoleted**

UGII_ROOT_DIR has historically been used to find the following in the UGII directory:

- Libraries and executables
- Configuration files

With the creation of the central runtime directory, there are two different locations for these files (nxbin and ugii), so the concept of UGII_ROOT_DIR is obsoleted. Use the UGII_BASE_DIR variable instead when you write custom application code and scripts.

While the NX install no longer sets UGII_ROOT_DIR, the definition on the system will remain to support earlier releases. If your code or scripts rely on UGII_ROOT_DIR, modify them to ensure they work in NX 11.

**Teamcenter code and scripts**

To provide backward compatibility with released versions of Teamcenter, all executables called directly by Teamcenter code or scripts are wrapped.

The wrapper executables just correct the settings of the UGII_BASE_DIR, PATH, and LD_LIBRARY_PATH variables that are set by the Teamcenter scripts and code, and then start up the real executable from the NXBIN directory. This enables support for the new runtime concept, while allowing NX to run with existing versions of Teamcenter.

These new wrapper executables must remain in the ugii and ugmanager directories since that is where Teamcenter code expects to find them. Two processes are shown for executables invoked from the ugii and ugmanager directories.

Executables are still in the UGII, UGMANAGER, STEP203UG, STEP214UG, and PVTRANS kits. Teamcenter code migration to the new central runtime directory structure is scheduled in a future Teamcenter release.
System requirements guidelines

Defining the minimum system requirements is difficult because key requirements, most notably memory, can vary dramatically from user to user. The following are general guidelines that you should consider before purchasing a system.

Processor performance

Although raw processor speed has a major impact on system performance, other factors also contribute to overall performance; for example, the type of disk drive (SCSI, ATA, or Serial ATA), disk speed, memory speed, graphics adapter, and bus speeds. The general rule is that "the faster the processor, the better the performance is," but this only applies when comparing like architectures. For example, it is difficult to arrive at performance expectations for an Intel processor when compared to an AMD processor just by looking at their respective processor speeds. There is also a general trend today to de-emphasize processor speeds and move to multi-core processors, which actually can have lower processor speeds.

SMP

Symmetric Multiprocessing (SMP) is supported in NX mostly via Parasolid, although a small number of NX capabilities have some threading. In general, it is not possible to quote a figure for the general performance improvement achieved by using SMP, since this improvement depends on the nature of the operations you are performing. You need to evaluate your actual performance gains using your own models. Functional areas that are SMP enabled in Parasolid include:

- Validity checking
- Boolean operations
- Wireframe
- Rendering
- Hidden line rendering
- Closest approach
- Faceting
- Mass properties

SMP is enabled by default with the variable `UGII_SMP_ENABLE`, which is located in the `ugii_env_ug.dat` file.

Multi-Core

Multi-core processors are similar to SMP because there are two or more actual processor cores but they are delivered in single processor packages. Siemens PLM Software has found that multi-core performance characteristics are similar to SMP. The one advantage of multi-core processors over SMP is that this technology has proliferated much faster than SMP and is now common in workstations, servers, and laptops.
Multi-core technology is complex and, depending on the configuration, can actually have a negative impact on performance. This is due to the potential conflict of multiple cores sharing system resources, such as cache, memory, and bus bandwidth, as well the need for the system to manage and control an increasing number of cores. Increasing the number of cores does not always translate into better performance. Although additional cores can improve NX performance, processor speed is still a vital measurement of NX performance.

Many systems enable you to turn off cores via the bios, which can enable you to compare performance with a different number of cores that are active. Some users may find that turning off some cores will actually improve performance. One micro-architecture (Intel) even does this automatically, shutting down unused cores and increasing the clock speed of the others.

The hardware vendors continue to improve their processor micro-architectures to better address the limitations of older multi-core technologies. New subsystems better integrate memory and other peripherals directly to the processors, resulting in major performance improvements. Buses are being eliminated, cores are better managed, and channel speeds continue to improve.

In summary:

- Turn SMP on only if you have an SMP system. Having it on in a single-processor system incurs a slight overhead.
- Turn SMP on if you have a multi-core system.
- Never assume that by simply adding more cores you will see better performance. Always test first.

**Memory**

For Windows 7, the minimum amount of memory is 4 GB, but we recommend 8 GB or 16 GB of memory as a starting point. Large models and assemblies or running multiple processes concurrently could boost the required memory for adequate performance.

**Graphics adapters**

All the NX certified systems contain graphics adapters that meet all Siemens PLM Software requirements and are fully supported by our hardware partners. The graphics adapters supported are carefully selected by working with our OEM partners as well as our graphics vendor partners. We do not recommend low-end, consumer, or game cards, since these graphics devices are developed for the DirectX market and are not well supported under OpenGL. Because a majority of platform/hardware problems are graphics related, it is critical that all the graphics adapters that NX supports are designed for OpenGL and have the highest level of support from our hardware vendors. We highly recommend that you only use supported graphics adapters and Siemens PLM Software certified drivers.

If you are running Microsoft Windows 7 you will require graphics adapters with more on-board memory, especially when AERO (the enhanced 3D feature) is turned on. The minimum recommended graphics on-board memory is 256 MB, and although graphics adapters with less memory will work, the performance may not be adequate, even with AERO turned off. If you have high-end graphics requirements, you will need to consider graphics adapters with 512 MB or higher on-board memory.

For the latest information on certified graphics cards and driver versions, please visit the Customer Support (GTAC) Web site.
Multiple monitors

Siemens PLM Software supports multi-monitors but with limitations. These limitations were necessary due to the large number of possible configurations. Other combinations may work, but these conditions are tested and supported by Siemens PLM Software. These guidelines could be extended or relaxed in the future.

The following is a summary of findings for the support of multiple monitors.

• NX 6.0.1 or higher - no older releases are supported.
• Two monitors only.
• LCD monitors only
• Run with native resolution and aspect ratio.
• Laptops are tested without docking stations or port replicators (direct connection only).
• Horizontal Scan mode (not Vertical) and only with identical monitors.
• Dual View (Nvidia) or Extended View (ATI) modes, but the user must have the display window entirely in either the primary or secondary monitor.

You do not have to comply with the configurations mentioned above, but Siemens must be able to duplicate the problem on the configurations in our labs before being able to investigate your issues.

Operating system requirements

Operating system requirements

This section documents operating system and service pack requirements.

Minimum Operating Systems

The following operating systems are certified and the minimum recommended for NX 11. Newer versions and service packs are certified as they are released.

<table>
<thead>
<tr>
<th>O.S.</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows (64-bit)</td>
<td>Microsoft Windows 7 Pro and Enterprise editions</td>
</tr>
<tr>
<td>Linux (64-bit)</td>
<td>SuSE Linux Enterprise Server/Desktop 12</td>
</tr>
<tr>
<td></td>
<td>Red Hat Enterprise Linux Server/Desktop 7</td>
</tr>
<tr>
<td>Mac OS X</td>
<td>Version 10.10.3</td>
</tr>
</tbody>
</table>

Windows XP and Vista

Windows XP support from Microsoft has ended and Vista was rarely deployed so these two versions of Windows are not supported by NX 11. Siemens PLM Software has not performed testing on these versions and cannot resolve any issues related to NX 11 running on these operating systems. If NX 11 is deployed on these versions of Windows, any issues will have to be replicated on Windows 7 before filing an incident report with GTAC.
Windows 10

Windows 10 is certified for NX 10.0.3 and later versions including NX 11. Any caveats or special instructions are provided in the SFB announcing support.

Linux Distributions

NX is developed using Linux standards and accepted Linux development conventions. Quality assurance testing is performed on the two versions of Linux listed in the table above. Siemens PLM Software cannot guarantee operation, performance, compatibility, or support on any other distributions.

The following is a list of information about the NX 11 development environment (for reference only):

<table>
<thead>
<tr>
<th>Component</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kernel</td>
<td>kernel3.10.0-123el7.x86_64</td>
</tr>
<tr>
<td>X Windows</td>
<td>libX11-devel-1.6.0-2.1</td>
</tr>
<tr>
<td>Motif</td>
<td>motif-devel-2.3.4-7</td>
</tr>
<tr>
<td>Open GL</td>
<td>mesa-libGL-devel-9.2.5-5.20131218</td>
</tr>
<tr>
<td></td>
<td>mesa-libGLU-devel-9.0.0-4</td>
</tr>
<tr>
<td>C, C++ Compiler</td>
<td>gcc 4.8.2</td>
</tr>
<tr>
<td>Java Development</td>
<td>1.8.0</td>
</tr>
</tbody>
</table>

Considerations and caveats

End of support for NX 32-bit

The memory addressing limitations of 32-bit processing and the widespread deployment of 64-bit systems has pushed OS providers, hardware vendors, and application developers to migrate their products to the 64-bit version. As a result, NX 11 is available as 64-bit only and customers will need to migrate to the 64-bit version, if they have not already done so.

Today, 64-bit processors are used in desktops, laptops, and workstations whether for consumers, gamers, or enterprise environments. The server version of Windows 7 is already 64-bit with no available 32-bit version. Siemens PLM Software supported 64-bit starting with UNIX and supported only 64-bit on Linux and Mac OS.

Microsoft Windows 8 and 8.1

Windows 8 and 8.1 were certified with NX 8.5.2 and are supported for that version and all subsequent versions of NX including NX 11.

Microsoft Windows 7

NX supports Windows 7 64-bit only; NX does not support Windows 7 32-bit. NX supports the Windows 7 Professional and Enterprise editions only.

Windows 7 requires considerably more resources (memory, disk, and so on.) than Windows XP, so it may be necessary to increase memory or disk, upgrade your graphics adapter, or even replace your workstation, to achieve the same performance available under Windows XP.
Note

Siemens PLM Software recommends a minimum of 4 GB of memory and a graphics adapter with at least 256 MB of on-board memory, but 512 MB or higher for those with large or complex models.

Besides the expected increases caused by this new enhanced operating system, Windows 7 has some special features that can increase memory usage quickly. The 3D desktop, user interface, and graphics capabilities of Windows 7 differ dramatically from those of Windows XP (you must think of this as a new OS and not a WXP upgrade) and can consume considerable memory resources. In addition, although Windows 7 supports OpenGL similar to previous versions, other changes in Windows have impacted the way graphics vendors use system resources (like memory). For Windows 7, the recommendation is to either increase on-board graphics adapter memory, or increase system addressable memory, or both.

Visit the Customer Support (GTAC) Web site for details of supported hardware configurations as well as for the latest graphics drivers.

Linux Requirements

NX supports SuSE Linux and Red Hat Linux, both 64-bit only. The minimum supported version of SuSE Enterprise (Desktop/Server) is 12 and Red Hat Enterprise (Desktop/Server) is 7.0. Newer versions will be supported via certification.

Note

Ensure that X11 and the Motif libraries are installed.

Visit the Customer Support (GTAC) Web site for details of supported hardware configurations as well as for the latest graphics drivers.

Java Runtime Environment

Starting in NX 8.5, the Java Runtime Environment (JRE) is no longer shipped with NX. NX requires JRE 8. To install the JRE, visit the Java download site at http://java.com/en/download/index.jsp

Java is used for the following products:

• NX Relations Browser
• Product Template Studio
• Manufacturing – Process Studio Author
• Command line version of the following translators:
  o CATIA V4
  o CATIA V5
  o Dxffdwg
Chapter 1: System Information

- IGES
- NX Pro E
- Step AP203
- Step AP214
  - Knowledge Fusion ICE
  - Online Help

**Note**
NX 9.x and earlier versions contain a different Help Search that requires the latest version of the Java plugin installed as an Add On to the browser. NX 10 and later versions do not require the Java plugin for the Help Search.

- Quality Dashboard
- Validation Rule Editor
- Batch Mesher
- Customer written NX Open Java programs
- NX Response Simulation Function Tools

**Java requirements for NX Open**

NX Open for Java is designed to be used with Java version 1.8.0 or higher.

**Post Processing of Abaqus ODB format results**

In the NX 11 release, NX uses Abaqus version 6.12 libraries to process ODB results files. For NX to use these libraries, you must first install Visual C++ 2008 X64 Runtime – v9.0.30729.4967.

**Note**
If you have Abaqus version 6.12 installed on your system, the required Visual C++ runtime should already be installed.

You can download this runtime from the Simulia customer support website:
http://www.3ds.com/products-services/simulia/support/

For more information on the system requirements for ODB version 6.12 files, see:
http://www.3ds.com/support/certified-hardware/simulia-system-information/abaqus-612/system-requirements-for-abaqus-612-products
Running Samcef in parallel

On Windows, when you run parallel computations with the built-in Samcef solver, Python 2.7 is required. In NX 11, that version of Python is not present. Install Python 2.7 on your disk and ensure that the Python directory is named Python27 (default name) and is included on your PATH variable. You can download the software from the Python website: https://www.python.org/downloads/

Note

The Python requirement does not apply if you have Samcef installed separately from NX.

Configuration files

Starting with NX 11, the NX configuration files on Windows are written to C:\users\<name>\AppData\Local\Siemens.

Installing the .NET Framework

The NXOpen for .NET API is a Windows-specific project that leverages the Microsoft .NET Framework component. Before you can execute a custom .NET application, you must install the .NET Framework 4.5. In addition, to replay a .NET journal, the .NET Framework 4.5 must be installed.

To download the .NET Framework 4.5, use the links on this page: Microsoft .NET Framework 4.5 (Web Installer).

Note

If you have installed Visual Studio 2012 SP1, then you have .NET Framework 4.5 installed by default.

Mac OS X Support

Hardware and installation requirements

Hardware and operating system requirements

The release of NX 11 on Mac OS X supports Apple Mac 64-bit Intel based systems. These include the MacBook Pro, iMac and Mac Pro systems. All available graphics subsystems are supported. The minimum version of Mac OS X required to run NX 11 is version 10.10.3. Later versions of Mac OS X are also supported, but there may be caveats.

Installation of NX on Mac OS X is supported only on an HFS+ file system. However, NX part files and other data files may be stored and retrieved from an NFS file system.

X11 requirements

NX 11 on Mac OS X utilizes X11 to support its graphical user interface. Xquartz 2.7.8 is required on OS X 10.11 "El Capitan." You will be prompted to install Xquartz when attempting to run any X11 application for the first time and guided through the installation by those prompts. Check for Xquartz updates from the X11→Check for X11 Updates.... dialog box.
You can download Xquartz at http://www.xquartz.org/

The X11 application must be running while using NX. The X11 application is started when NX or any other X-based application is invoked.

**Installation**

Installation must be performed from an account with administrator privileges. To install, double-click on the `ug_install` script.

**Product notes**

**Mouse focus policies**

The X11 mouse focus policy specifies how the mouse advises X11 on which window is active and can receive keystrokes. The **Click-through Inactive Windows** and **Focus Follows Mouse** operations are often preferred to the X11 defaults.

In the X11 bundled with Lion, the mouse focus policies are set by choosing `X11→Preferences, Windows` tab. The **Windows** tab contains the following options:

- **Click-through Inactive Windows**
- **Focus Follows Mouse**
- **Focus On New Windows**

You must restart X11 for a change to take effect. Note that the setting applies only to the user’s own preferences, not to the system wide preferences. Refer to the `quartz-wm man` page for details.

**Pasteboard/Clipboard Setup**

The X11 Pasteboard policy defines how the Mac OS Pasteboard communicates with the X11 CLIPBOARD. To ensure proper clipboard copy/paste behavior in NX, syncing between the Mac OS Pasteboard and X11 CLIPBOARD should be disabled.

In the X11 bundled with Lion, the Pasteboard policies are set by choosing `X11→Preferences, Pasteboard` tab. Uncheck the **Enable syncing** option.

Note that the setting applies only to the user’s own preferences, not to the system wide preferences. Refer to the `quartz-wm man` page for details.

**3D Input Devices**

Support for 3Dconnexion input devices is available for NX on Mac OS X through the use of drivers and software available directly from 3Dconnexion. Use the following link to download the software and get installation information.

http://www.3dconnexion.com/service/drivers.html

**Plotting**

MAC OS X printing systems handle PDF files in native mode. NX Plotting takes advantage of this by creating a PDF file which it hands off to a Macintosh application that handles the printing task.
Because these native tools can interface with the printing system, the usual SDI plotting software used with other platforms is not used on MAC OS X.

**Teamcenter Integration support for Mac OS X**

Teamcenter Integration (TCIN) is supported on the Mac platform when you run in a four-tier environment. The operation and functionality of Teamcenter Integration on the Mac platform is the same as on other platforms.

**Note**
The Teamcenter two-tier environment is not supported.

The Mac client setup in a four-tier Teamcenter environment is similar to the setup for Linux. However, you have to install the Mac client as a TCCS installation instead of an FMS installation. Typically, the TCCS install is done as part of the RAC TC install, but since the Teamcenter RAC install does not support the Mac platform, the TCCS standalone installer needs to be used. This installer is provided on the Teamcenter Mac DVD or Mac install download. For install and setup information, see the Teamcenter installation documentation.

After installation is complete, you can create a script to setup TCIN for use before launching NX. The following is a sample script:

**Note**
- The values and paths used here are for example only. Use the values and paths that are applicable for your site.
- The line:
  
  defaults write com.siemens.plm.nx11 PIM Yes

  sets the -pim option to Yes. You can set this back to No to run native NX.
- You do not set the user name (-u) and password (-p) options in the script. You enter these in the dialog box that is displayed when you run NX.

**Sample script:**

```
defaults write com.siemens.plm.nx11 FMS_HOME /home/UGS/Teamcenter/Tc11/tccs
defaults write com.siemens.plm.nx11 UGII_UGMGR_HTTP_URL http://annpc38:7001/tc/aiws/aiws
defaults write com.siemens.plm.nx11 PIM Yes
defaults write com.siemens.plm.nx11 JAVA_HOME /System/JavaVM.framework/Versions/1.5/Commands/java
defaults read com.siemens.plm.nx11
FMS_HOME=/home/UGS/Teamcenter/Tc11/tccs; export FMS_HOME
JAVA_HOME=/System/Library/Frameworks/JavaVM.framework/Versions/Current/Commands/java
```

NX 11 Beta Release Notes  1-13
Caveats

Mac OS X 10.10

If you are using Mac OS X version 10.10 (Yosemite), the minimum supported version for NX 11 is version 10.10.3. Apple’s release of Yosemite (Mac OS X 10.10) does not include the X11 libraries required by NX.

Xquartz 2.7.7 is required. You will be prompted to install Xquartz when attempting to run any X11 application for the first time and guided through the installation by those prompts. Check for Xquartz updates from the X11→Check for X11 Updates.... dialog box.

CAE

NX 11 on Mac OS X does not support any CAE functionality. CAE modules and specialized NX functions that depend on CAE are not supported.

Plotting

Plotting of high quality images using the View→Visualization→High Quality Image command does not work.

Relations Browser

The relations browser is not supported. When you choose Assemblies→WAVE→Relations Browser, the command does not work.

Spreadsheet support

NX 11 on Mac OS X does not support the use of any spreadsheet.

Enabling the Alt key

When you use NX, the Alt key can be very handy. The Mac OS does not automatically enable the Alt key for use with NX. You have to update the X server’s keyboard mapping.

Redefine the key on the keyboard

To enable the Alt key, you need to update the keyboard mapping to redefine the key labeled alt/option. Enter the following command in a Terminal window:

```bash
defaults write org.x.X11 option_sends_alt -boolean true
```

The alt/option key now sends Alt_L and Alt_R instead of Mode_switch.
Supported hardware and graphics

The list of currently supported hardware and graphics cards can be found on the GTAC support page Customer Support (GTAC) Web site at Hardware and Software Certification→Hardware (Graphics Card) Certifications. This opens a spreadsheet that has tabs for supported systems and graphics.
Named user NX licensing

If you are using named user NX licensing, the way NX licenses are managed is different. When you run in managed mode (Teamcenter Integration) and start NX, NX no longer connects to a license server and instead uses Teamcenter to check out your named user license. Teamcenter then tracks the number of unique users during the month. When that number is exceeded, new users are denied access.

This licensing method enables tracking by user instead of using concurrent licensing. At startup, NX sends a license string to Teamcenter so it can perform the license check. The license string used determines the modules that are available. To use named user licensing, set the SPLM_NAMED_USER environment variable to the license you have purchased. Valid values are:

- nx_design_nu
- nx_adv_sim_nu
- nx_ind_design_nu
- nx_mold_design_nu
- nx_prod_design_nu

By using this licensing method, you can continue to have access to an NX module without getting locked out when the number of available licenses is filled.
Linux graphics caveats

Some applications experience a severe X server crash with Red Hat 7 (and later) and SuSE 12. The crash of the server causes the user to exit the login session. When this occurs, the user must login again. This problem has only been seen on nVidia graphics boards. If you are using an older driver, the first recommendation is to try the latest graphics driver. If this problem is observed in other applications, the following workaround can be applied.

**Note**

Use this workaround only if you experience the problem, as it can cause a performance slowdown. To work around this problem, modify `/etc/X11/xorg.conf` and add the following line to the `Device` section for nVidia after the `Driver` line.

```
Option "UseCompositeWrapper" "true"
```

Thus, after the change, the device entry in `xorg.conf` might look like:

```
Section "Device"
  Identifier   "Videocard0"
  Driver       "nvidia"
  Option       "UseCompositeWrapper" "true"
EndSection
```

You must login as root in order to make this change. It is prudent to make a backup copy of `/etc/X11/xorg.conf` before making this change. Each time the nVidia driver (the same or a newer version) is installed, you need to take the above steps to ensure the `Option` line is included. In order for the change to take effect, you must restart the X server by either rebooting or pressing Ctrl+Alt+Backspace (if you are in a live X session).

**Note**

With some AMD configurations on Red Hat and SuSE, a different problem has been observed whose similarity with the problem seen with the nVidia configuration may cause you to believe it is the same problem. This problem causes NX and many X applications to fail with a segmentation violation or a memory fault at the start. However, this problem is likely due to the AMD graphics driver not being configured correctly. The simple solution to this problem is to do the following:

1. Login as root
2. Make a backup copy of `/etc/X11/xorg.conf`.
3. Remove `/etc/X11/xorg.conf`.
4. Regenerate a new `xorg.conf` by running the command:
   ```
   atconfig --initial
   ```
5. Restart the X server.
Initializing the JVM

In some cases, NX is not able to create the Java Virtual Machine (JVM) properly on Windows. The root cause in these scenarios is insufficient memory to start the JVM. In most cases of insufficient memory Java is able to report back an error code indicating this problem. However, in some cases Java reports a generic error message that NX then displays. The typical error message is:

Can’t initialize the Java Virtual Machine (JVM)

When running a Java application, such as the Wave Browser or Interactive Class Editor, NX may give an unexpected error due to this problem.

Starting in NX 8, if NX detects that there is not enough memory available for the JVM, an error message is given and information is provided in the syslog. The following is an example of the syslog information:

The JVM could not be created due to not enough memory.
The Java heap size must be contiguous and the largest contiguous block available is outputted below.
Windows largest block free
=================================
Maximum block 267Mb
=================================
Please note, this number is to be used as suggestion for setting the heap size. It is unlikely that you will be able to utilize the full amount.
If you need a heap size larger than what is possible you can try to use the /3GB switch or its equivalent, if available for the Operating System you are on. Otherwise your other option is to use Remoting. Please consult the NX Open Programmer's Guide for more information on this topic.

Reset the size of the Java heap

To remedy this problem, you can reset the size of the Java heap that NX uses. Choose **File→Execute→Override Java Parameters** to open the dialog box and set UGII_JVM_OPTIONS to the size of the Java heap. You can experiment with the size of heap that you need, but if the JVM is already started then you cannot change the UGII_JVM_OPTIONS setting.

It is recommended that you use both the **–Xmx** and **–Xms** options together. Both of these are needed as Java may determine default values for the heap size that are not possible with the machine’s current memory load. For example:

UGII_JVM_OPTIONS=–Xmx=50M –Xms=50M

When trying to determine the size of the heap, keep in mind that if the heap size is too small, a Java program you are trying to run may not run. This could be due to the amount of memory available on the machine, or due to multiple Java processes running. This can be the case with the Wave Browser where there is a client and server process.

Once you find a value that works, you can modify the UGII_JVM_OPTIONS value in the **ugii_env.dat** file so you don’t have to reset it in the **NX Open Java Parameters** dialog box each time you start an NX session.
NX variables in the ugii_env.dat file

Standard and modified environment variables

The ugii_env.dat file contains the standard environment variables for NX. You can override these variables with the ugii_env.dat file. This file is essentially empty when delivered. You can define new values for the environment variables in this file and they take precedence over the values defined in the ugii_env_ug.dat file.

The ugii_env.dat file should be used to modify any standard NX environment variables or add new ones.

Both the ugii_env_ug.dat and ugii_env.dat files are located at <UGII_BASE_DIR>\ugi.

Note
You can make all, some, or none of the changes to the variables in the ugii_env_ug.dat file. However, it is recommended that you use the ugii_env.dat file to define all of the values in use at your site.

Using the ugii_env.dat file

The following apply when using the ugii_env.dat file:

• Define the variables before the #include statement.

• The first variable defined is used. If you have the variable defined twice in the file, only the first one is used.

Note
This also applies to the ugii_env_ug.dat file.

• You cannot have spaces in the variable names.

Designate a single ugii_env.dat file for all users

You can place the ugii_env.dat file in a central location for all users to access.

For each user, set the environment variable UGII_ENV_FILE to the location of the file. For example:

UGII_ENV_FILE=G:\common\version_env_vars.corp_standards

Note
The file can have any name but must be a fully qualified path.

Statements you can use in the ugii_env.dat file

The statements that you can use in the ugii_env.dat file are shown below with examples:

• #if/#else/#endif
Used to check for specific conditions and then to define variables based on those conditions. Conditions that can be checked are:

- **FILE** - Check for the existence of a file
  ```
  #if FILE ${UGII_BASE_DIR}\UGII\html_files\start_${UGII_LANG}.html
  UGII_CAST_HOME=${UGII_BASE_DIR}\UGII\html_files\start_${UGII_LANG}.html
  #else
  UGII_CAST_HOME=${UGII_BASE_DIR}\UGII\html_files\start_english.html
  #endif
  ```

- **platform** - Check for a specific platform. Possible values:
  - x64wnt
  - Lnx64
  - macosx
    ```
    #if Lnx64
    UGII_CAM_THREAD_MILL=${UGII_CAM_THREAD_MILL_DIR}thrm.so
    #endif
    ```

- **$variable = “value”** - Check for a specific value for a previously defined environment variable
  ```
  #if $$UGII_LANG = "simpl_chinese"
  UGII_COUNTRY=prc
  UGII_COUNTRY_TEMPLATES=${UGII_BASE_DIR}\localization\${UGII_COUNTRY}\simpl_chinese
  #endif
  ```

- **$variable != “value”** - Check for a previously defined environment variable that does not have the specified value.
  ```
  #if ${UGII_PACKAGE_DIRECTORY} != ""
  #if FILE $UGII_PACKAGE_DIRECTORY\ugii_package_env.dat
  #include $UGII_PACKAGE_DIRECTORY\ugii_package_env.dat
  #endif
  #endif
  ```

- **#include**
  Used to include a specified environment file at the current location
  ```
  #include $UGII_PACKAGE_DIRECTORY\ugii_package_env.dat
  ```

**Enabling context sensitive help in local languages for customer defaults and KF**

When using localized language versions of the NX Help, to get context sensitive help to work for Customer Defaults or Knowledge Fusion you need to edit the following two environment variables to point to the localized help:

- **UGII_CSHELP_DEFAULTS_DOCS**
- **UGII_CSHELP_FUSION_DOCS**

For example, to enable context sensitive help for Japanese Customer Defaults help you would set:

```
UGII_CSHELP_DEFAULTS_DOCS=${UGII_UGDOC_BASE}/data_services/resources/nx/${UGII_MAJOR_VERSION}/nx_help/ja_JP/graphics/fileLibrary/nx/cust_defaults
```
Browser requirements

Browser and plug-in requirements

The NX suite of documentation (Help, What’s new Guide, and Release Notes) is Learning Advantage courses are provided in an HTML format that is displayed in your local Web browser.

The documentation requires a web server. You can install the Siemens PLM Documentation Server, which sets up a local web server on each workstation, or install the documentation into an existing company-wide server.

The latest versions of web browsers are recommended to comply with the latest browser security updates.

Windows browser support

- Internet Explorer
- Mozilla Firefox
- Google Chrome

Linux browser support

- Mozilla Firefox

  If you have other Mozilla web browsers installed on your system, make sure either your default browser is set to the correct Firefox version, or the UGII_HTML_BROWSER environment variable in your ugii_env.dat file is set to the supported Firefox version.

Mac OS X browser support

- Safari
- Google Chrome

Downloading browsers

These browsers are free and can be downloaded from the following Web sites:

  Internet Explorer — http://www.microsoft.com

  Firefox — http://www.mozilla.org

  Safari — http://www.apple.com

Windows .chm files

Some parts of the Help are delivered in Microsoft Compiled Help format (.chm). Windows security enhancements prohibit opening .chm Help files across a network, so you must install those files on your computer. If you install .chm Help files on a server, you cannot read the Help across the network.
Flash required for videos

To watch videos and simulations, you must have the Adobe Flash Player installed as a plug-in to your browser. You can download the Flash Player (free) at the Adobe Flash Player site.

Adobe Acrobat Reader

Some portions of the Help may be delivered as PDF, which requires the Adobe Acrobat Reader. You can download the free reader from http://get.adobe.com/reader/.
Browser caveats

Browser caveats for Internet Explorer

IE9 compatibility view. The HTML Help is fully supported when launched with the http:// protocol or the file:// protocol. However, if you are viewing an older version of the Help from a local installation, such as D://, you may need to enable the Compatibility View. In IE 9, perform the following:


2. In the Compatibility View Settings dialog box, select Display all websites in Compatibility View.

Browser caveats for Firefox

• Mozilla recommends that you upgrade to the latest version of Firefox due to security issues surrounding Java. They do not recommend using older versions of Firefox. For more information, see http://support.mozilla.org/en-US/kb/latest-firefox-issues.

• The default behavior in Firefox 3.0.5 is for new pages to be opened in a new tab. This affects the behavior of the global search since new links will open in a tab instead of a new window. You can configure Firefox to open a new window instead of a new tab by selecting Tools→Options→Tabs.

• Typically, you install and launch the Help from the http:// protocol which is fully supported. However, if you want to launch from a UNC path (file://), Firefox has a default security setting that prevents the Help from launching correctly. To enable this, you need to change the value of the security.fileuri.strict_origin_policy preference:

1. In the address bar, type about:config.

2. In the Filter field, type security.fileuri. If the value of the security.fileuri.strict_origin_policy preference is set to TRUE, set the value to FALSE. Double-click on the value to toggle it.

3. Restart the browser.

• If you are trying to open a .chm file that you have accessed from a web server (not from a local install), you may not be able to open the file as it is blocked. To unblock, right-click on the file and choose Properties, then select the unblock option.

Browser caveats for Chrome

Typically, you install and launch the Help from the http:// protocol which is fully supported. However, if you installed with the file:// protocol, you have to run Help from the command line. To fix this, see http://code.google.com/p/chromium/issues/detail?id=39767.
Licensing Caveats

General licensing caveats

License files and license server

The following are applicable to license files and the license server:

- Merging of license files is not supported.

Example

You can not merge a pre-TC 2007 MP3 or pre-NX 5 license file, which uses the `uglmd` license daemon, with a TC 2007 MP3, NX 5, or NX 6 license file, which uses the `ugslmd` daemon.

NX 11 requires and tests for the latest version of the `ugslmd` vendor daemon. This vendor daemon is supplied with NX 11 and must be installed and initiated prior to starting NX 11. If an older daemon is utilized, a generic NX License Error dialog box is displayed during start-up. In addition, the syslog will contain an error message that the daemon version is older than the client.

- The SPLM License server install requires that Java 1.8.0_45 is installed on the system.

NX Borrowing is version specific

NX license borrowing is version specific due to dependencies within the third party licensing software used by Siemens PLM Software. To ensure that NX works on a borrowed license, you should always utilize the borrow tool supplied with that NX version. For example, a license borrowed using the NX 11 borrowing tool will work for NX 11 but cannot be used to run NX 10. In addition, you cannot borrow licenses for two NX versions simultaneously on the same workstation.

Licensing Guides

Refer to the NX 11 software DVD for the most recent version of the various licensing, administration and server installation guides. The licensing guides included in the NX 11 Help are outdated and should not be used.
Licensing caveats for Windows

The following caveats are applicable to Windows platforms only.

License Option tool

The License Option tool should only be used to borrow NX licenses, even though it may display other licenses. The License Option tool does not filter features in the license file that are of an earlier version than NX 11, such as Teamcenter lifecycle visualization, so these licenses are displayed in the tool. Attempting to borrow a license other than NX 11 causes an error in the License Option tool.
Licensing caveats for Linux

Additional software to support licensing

SuSE and Red Hat require the following to be installed:

• LSB 3.0
Licensing caveats for Mac OS X

License server preference settings

The license server used by NX is specified during NX installation, but it may be necessary to view or change the license server setting after installation. To do that, open a Terminal window and use the following commands.

- To read the current license setting:

  defaults read /Library/Preferences/com.siemens.plm.nx11

  This command will show the current setting. For example “SPLM_LICENSE_SERVER” = “28000@myserver.mycompany.com”

- To change the license setting:

  The following command will set the SPLM_LICENSE_SERVER preference to “myserver1”:

  defaults write /Library/Preferences/com.siemens.plm.nx11 SPLM_LICENSE_SERVER 28000@myserver1.mycompany.com

  You may need to use “sudo” if the Preferences file is writeable only by an administrator. For example

  sudo defaults write /Library/Preferences/com.siemens.plm.nx11 SPLM_LICENSE_SERVER 28000@myserver1.mycompany.com

  You do not need to restart the machine after setting the NX preference.

License server naming on Mac OS X

Mac OS X is different from many other operating systems due to the fact that when the networking conditions change, the hostname of a Mac workstation will change.

For example, while on the network (<mysite>.com), the hostname is mac1.<mysite>.com. While disconnected from all networks, the hostname changes to mac1.local. FLEXnet relies on the use of the hostname to locate the server so this hostname change causes the license server daemons to lose communication and prevents the client application from connecting to the license server. The result is an NX startup error caused by the inability to get a license.

This condition usually occurs when a single user on a laptop installs the license server and NX on the same laptop.

Use one of the following recommendations to help prevent or resolve this situation:

- Install a license server on a workstation or system that has a stable domain. It is recommended that a central license server be used for all client applications.

- Use the local IP address (127.0.0.1) for the hostname as follows.
  
  Change the file from:

  SERVER Yourhostname COMPOSITE=a1234567890b 28000

  To:

  SERVER 127.0.0.1 COMPOSITE=a1234567890b 28000
To:

SERVER 127.0.0.1 COMPOSITE=a1234567890b 28000

When asked for the license server value during the client application install, provide the following:

28000@127.0.0.1

- Request a standalone non-served license file. These license files do not need a license server but simply need to have the application point to a file. These license files are ideal for a user with only one seat of an application that is to be installed on a laptop. Contact your customer service representative for a standalone license file.

Common licensing tool on Mac OS X

The Common Licensing Tool (CLT) for Mac OS X is a licensing utility that enables the user to select bundles and borrow licenses.

Bundle selection

The interface to the Bundle Selection in the CLT for Mac is essentially the same as in the License Options application on Windows.

In order to select a bundle, you highlight the bundle in the Available Bundle list and click the Add button, or double click the selected item. The item is moved to the Selected Bundle list.

To remove an item from the Selected Bundle list and return it to the Available Bundle list, you can highlight the bundle you wish to return to the Available Bundle list and click the Remove button. Alternatively, you can double click the bundle to remove it from the Selected Bundle list.

No bundles are actually applied until you click OK. When you click OK, the modifications to the selected bundle list are written to a file in the user’s home directory, called splms_cl.reg.

The CLT for Mac allows for product-specification in the bundle settings. Thus, the name of the key for the bundle value is <PRODUCT>_BUNDLES, where <PRODUCT> is the product in question (such as NX, in which case the key would be NX_BUNDLES).

Borrowing

Borrowing with the CLT is similar to borrowing with License Options for Windows. To borrow a license feature or features, you select the features that you want and then choose the return date and time. Then you click the Borrow License(s) button. Finally, to perform the actual communication with the license server and borrow the selected items, click OK.

To return a borrowed license, you select the item you want to return, click the Return License(s) button, and then click OK.

The Reset button will cause all Return Dates to go back to the original state they were in when you initially launched the tool. Thus, items that were not borrowed will have their return dates cleared, and any items that had the return date changed or cleared will be reset to their original value when the tool was launched.
Product compatibility - supported version combinations

Teamcenter and NX

The following table lists which version combinations of Teamcenter and NX are supported.

<table>
<thead>
<tr>
<th>Teamcenter UA</th>
<th>NX 8.5.3</th>
<th>NX 9</th>
<th>NX 9.0.x</th>
<th>NX 10</th>
<th>NX 10.0.x</th>
<th>NX 11</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.3</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9.1</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>10.1</td>
<td>✓</td>
<td>✓</td>
<td>(5, 6)</td>
<td>(7, 8)</td>
<td>(7, 9)</td>
<td>(13,15)</td>
</tr>
<tr>
<td>11.2</td>
<td></td>
<td></td>
<td>(10, 11)</td>
<td></td>
<td>(14, 15)</td>
<td></td>
</tr>
</tbody>
</table>

(1) Only Teamcenter UA 8.3.3.6 or higher.
(2) Only Teamcenter UA 9.1.2 or higher.
(3) Only Teamcenter UA 10.1.0.1 or higher.
(4) Only Teamcenter UA 9.1.2.4 or higher.
(5) Only Teamcenter UA 10.1.0.1 or higher.
(6) For NX 9.0.2, Active Workspace 2.1. For NX 9.0.3, Active Workspace 2.2, 2.3, and 2.4.
(7) Only Teamcenter UA 10.1.2.2 or higher.
(8) Active Workspace 2.2, 2.3, and 2.4.
(9) For NX 10.0.1, Active Workspace 2.2, 2.3, and 2.4. For NX 10.0.2, Active Workspace 2.3 and 2.4. For NX 10.0.3, Active Workspace 2.4, 3.0, and 3.1.
(10) For NX 10.0.2 MP1 and higher, only Teamcenter UA 11.2.1 or higher
(11) For NX 10.0.3 MP6 and higher, only Teamcenter UA 11.2.2 or higher
(12) For NX 10.0.2 MP1, Active Workspace 2.3 and 2.4. For NX 10.0.3, Active Workspace 2.4, 3.0, and 3.1.
(13) Only Teamcenter UA 10.1.5 or higher.
(14) Only Teamcenter UA 11.2.2 or higher.
(15) Active Workspace 3.1.
Note

For information on version compatibility for Teamcenter and Teamcenter lifecycle visualization, see the Teamcenter documentation.
## NX compatibility with Spreadsheet

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 10 64-bit</td>
<td>10 Pro &amp; Enterprise</td>
<td></td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Not supported</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 8 64-bit</td>
<td>8 Pro &amp; Enterprise</td>
<td></td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Not supported</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 7 64-bit</td>
<td>7 Pro &amp; Enterprise</td>
<td></td>
<td>Supported</td>
<td>Supported &amp; certified</td>
<td>Supported &amp; certified</td>
<td>Certified</td>
<td>Not supported</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Linux 64-bit</td>
<td>Suse Enterprise</td>
<td></td>
<td>Certified &amp; supported</td>
<td>Certified &amp; supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SuSE Linux 64-bit</td>
<td>12</td>
<td></td>
<td>Certified &amp; supported</td>
<td>Certified &amp; supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Red Hat Linux 64-bit</td>
<td>Red Hat Enterprise V7</td>
<td></td>
<td>Certified &amp; supported</td>
<td>Certified &amp; supported</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Note

- The NX spreadsheet interface is not supported on the MAC platform in NX 11.

- The 64-bit versions of Microsoft Excel are not yet supported by NX. The 32-bit version of Excel is installed by default on the Windows 64-bit Operating Systems.

- Microsoft Starter Edition is not supported by NX due to lack of support for Add-in's, Macro's, Math and Equation Editing.

- If you open a part with Excel 2003 data or older and then save the spreadsheet, NX updates the data to Excel 2007 or later (to the Excel version currently running with NX).

- If you launch a spreadsheet command such as Spreadsheet or Part Family on a system having Excel 2003 or older version as the default spreadsheet application, NX displays an error message and does not proceed with the launched command.

---

1. When you launch Excel 2016 spreadsheet from NX and exit the spreadsheet using the Windows Close button, Excel launches a dialog box prompting you to either accept the changes, discard the changes and exit, or to cancel the spreadsheet exit. If you select the cancel operation, subsequent use of the Windows Close button will close the spreadsheet without displaying the dialog box described above and does not return control back to NX. At this point, you may need to terminate the NX process. To avoid this situation use the Excel File tab—Close command instead of the Windows Close button. A fix for this issue is expected in a future version of Microsoft Excel 2016.
## NX applications unsupported on specific platforms

The applications listed are not supported on the specified platforms.

<table>
<thead>
<tr>
<th>Application</th>
<th>Functionality</th>
<th>Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway</td>
<td>File Print</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td></td>
<td>File Open of SolidWorks files</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td></td>
<td>Advanced Studio Rendering Style Mode</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Plotting</td>
<td>Plotting of high quality images using the <strong>View</strong>→<strong>Visualization</strong>→<strong>High Quality Image</strong> command</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td>Manufacturing Milling</td>
<td>Siemens 840D virtual machine tool controller (VNCK)</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td></td>
<td>Manufacturing Wizard Builder (part of Simulation Process Studio)</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Pre/Post</td>
<td>Abaqus OBD result file reading</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td></td>
<td>Topology Optimization and Shape Optimization</td>
<td>Not supported on: Linux Redhat, MAC</td>
</tr>
<tr>
<td>Design Simulation</td>
<td>All</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td>Motion</td>
<td>Motion Mechatronics co-simulation</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Teamcenter Integration</td>
<td>Launching NX from Active Workspace web client</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td>Human Modeling</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>PCB Exchange</td>
<td>Automatic creation of ESC solution</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td></td>
<td>CR5000 pcb files Import / Export / Compare (PCB Exchange for Zuken limitation)</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Mechatronics Concept Designer</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>CMM Inspection Programming</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Simple NX Application</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Programming (SNAP)</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
</tbody>
</table>
Support for touch enabled devices

In NX 11, you can interact and manipulate 3D models and control the overall user interface using touch screen and stylus. The support for touch enabled hardware follows a slightly different support model than what is provided through the NX certification program. We have tested NX on a number of Windows based touch screen laptops, monitors, and tablets. However, support for these devices and other comparable systems is limited as they are not true workstations and do not qualify for our full certification program. Support for these devices is limited as follows:

• Graphics performance issues are not supported as most of these devices do not offer the level of driver support available on workstations.

• Graphics quality and display issues are not supported unless they can be duplicated on a certified workstation.

• Any issue determined to be caused by the graphics driver is not supported.

• Performance issues with NX are not supported on these systems unless reproducible on certified workstations.

Caveats aside, we have tested and used for development a variety of touch based systems from HP, Dell, Microsoft, and others and have found them acceptable for general usage of NX.

Additional Notes

• NX supports touch devices on Windows 7, Windows 8, and Windows 10 operating system.

• Only stylus configurations support pre-highlighting. The most commonly used devices supporting stylus are the Surface Pros.
Chapter 2: Teamcenter Integration for NX
Product Notes

Active Workspace

Teamcenter Integration works with Active Workspace 3.1.
Launching NX from the Active Workspace web client is not supported on the Mac.

Use Item Name instead of Number customer default

The Use Item Name instead of Number customer default is removed. To specify the display of the Item name or Item ID for an object in NX, specify the desired property as the displayed property in the Teamcenter BMIDE. NX uses the same setting as Teamcenter. This provides consistency for displayed names when viewing objects in Teamcenter and NX.

In addition, the Always use Item Number for Interpart Expressions customer default is removed.

Part number and revision customer defaults

The Part Number Prefix, Part Number Suffix, Part Revision Prefix, and Part Revision Suffix customer defaults are moved to the Legacy tab. They are available for systems using legacy display names and to support NX Open programs. The NX Part Display Name is now based on the display name as defined in Teamcenter.

Variant configuration

The Variant Configuration command is removed. To apply a variant configuration to an assembly, load the assembly using the Variant Rule option in the Assembly Load Options dialog box.

Teamcenter names and values of properties localized

In Teamcenter, there is now the capability to have the names and values of properties translated and displayed in multiple languages. You can see this functionality in some areas of NX (not all areas of NX incorporate this functionality), such as the Teamcenter Navigator, Part Family template spreadsheet, and New Item, Save, Save As, Import, and component properties dialog boxes. This is applicable for Teamcenter properties such as: property names, property values, list of values, and BMIDE elements (type names).

Note

This functionality is applicable for Teamcenter 11.2 or higher.

When you run NX, the language set by the environment variable UGII_LANG determines the language that is used to display the names and values of TC properties in NX.

If you do not have translated values defined in TC for the properties, or you do not want NX to display the translated values, set the following environment variable:

  UGII_NO_TC_LOCALIZATION=1

When this environment variable is set, the property values shown in NX are always the internal value (non-translated) and there is no indication in NX that the value has a translated value defined in Teamcenter. This is the same behavior that NX had prior to NX 10. However, the environment variable
does not change the way the property names are displayed. If the property name has a translated value that matches the UGII_LANG setting, the translated (localized) name is still shown in NX.
Caveats

Running refile with escape character

If you set the following Teamcenter preference to # so that # becomes an escape character, refile does not work for a part that contains the # character in its ID.

   TC_escape_character

Starting NX in four-tier Teamcenter environment with WebLogic 10 MP2

When you are running Teamcenter in the four-tier environment with WebLogic 10 MP2, NX may not start with no error messages displayed. This could be due to problems with the WebLogic server.

Note

This is applicable only when you are using the WebLogic 10 MP2 Application Server.

Perform the following steps to modify the Weblogic XML file:

1. Stop the WebLogic application and locate the tc.war file in the WebLogic domain (typically in the autodeploy directory).

2. Open the tc.war file using Winzip and extract the weblogic.xml file to a temporary location.

3. Open the weblogic.xml file using an editor (XML or text editor) and add a cookie-http-only XML element with the value of false in the session-descriptor element. For example:

   <session-descriptor>
   ...
   <cookie-http-only>false</cookie-http-only>
   </session-descriptor>

4. In Winzip, delete the old weblogic.xml file.

5. Add the modified weblogic.xml file in your temporary directory into Winzip. To do this, drag the web-inf folder that contains the weblogic.xml file and drop it into Winzip. Ensure the path of the weblogic.xml file is web-inf/.

6. Restart the WebLogic application.

Creating an Alt Rep assembly using File New

You cannot have an assembly that is an alternate representation (Alt Rep) that has children that are not also Alt Reps. The part types of the parts (Alt Rep) must match the part type of the assembly (Alt Rep).

However, when you choose File→New to create a new assembly and use the Blank template, NX lets you create an Alt Rep assembly with children that are not also Alt Reps. This causes problems when you use the assembly in NX.
Translators only supported in Teamcenter two-tier environment

Teamcenter only supports the installation of the following NX translators in a Teamcenter two-tier environment, the Teamcenter four-tier environment is not supported:

- NXClone
- NXRefile (not supported on Linux)
- NXtoPVDirect

VLA Attribute Affix options modified

The VLA Attribute Affix customer default (Teamcenter Integration for NX—User Attributes, All tab) is modified. The new options [Numeric] and :Numeric introduced in NX 8 caused problems when there are references to VLA (variable length array) attributes in parts created prior to NX 8. The [Numeric] and :Numeric options are now set to _Numeric when selected. You should use _Numeric if you are setting this option for the first time.
Chapter 3: Fundamentals
Product Notes

Classic Toolbar user interface retired from the Windows platform

The Classic Toolbar user interface is retired from NX11 and the Ribbon Bar is the only available user interface on Windows. The Ribbon Bar interface provides access to more commands than the Advanced role in Classic Toolbar mode with a larger graphics window. And it does all this with logical groupings, informative text and a mixture of icon sizes. In addition to these traditional aspects of the Ribbon Bar, the NX ribbon is fully customizable and contains NX-specific extensions such as border bars. The result is a more organized user interface with the richness of Advanced and the discoverability of Essentials.

For instructions on how to migrate from Classic interface to Ribbon bar interface, see NX Ribbon-Customization and Transition.
Caveats

Bookmarks

If you create a bookmark file with Ray Traced Studio mode enabled, when the bookmark is applied Ray Traced Studio mode will not be in effect.

If you create a bookmark file when displaying a View Section with clipping disabled, when the bookmark is applied the section may be incorrectly clipped.

If you try to apply a bookmark file when

1. the bookmark file is not for the current displayed part and
2. the number of views in the layout at the time when the bookmark file was created is not the same as the number of views in the current displayed part

then the number of views in the layout may be wrong after the bookmark file is applied. Applying the same bookmark file a second time corrects the number of views.

Using Teamcenter as the issue site for NX Issue Management

When you use NX Issue Management, you can specify Teamcenter as the issue site only when Teamcenter Issue Manager is deployed via Teamcenter Environment Manager at the server side. NX displays an error message if it cannot connect to Teamcenter Issue Manager. For more information, refer to the Teamcenter Environment Manager Help.
Chapter 4: Customer Defaults
Customer defaults

Customer defaults allow you to customize the operation of NX. The initial settings and parameters of many functions and dialog boxes are controlled by customer defaults. You can view them by choosing File→Utilities→Customer Defaults.

For a description of the new/modified customer defaults for this release, see Customer Defaults for NX 11.

For additional information on customer defaults, see System administration→Customizing the NX installation→Customer Defaults in the NX online help. For a listing and description of all customer defaults, see Fundamentals→Customer Defaults in the NX online help.
Chapter 5: CAD

Modeling

Product Notes

Commands being retired in NX 12

The following commands will be available in NX 11 only through environment variables, and will be fully retired and dropped from the product line in NX 12:

- **Move Defining Point (to be retired)** - Restore with NX_MOVE_POINT_ON environment variable.

- **Move Pole (to be retired)** - Restore with NX_MOVE_POLE_ON environment variable.

- **Isoparametric Trim/Divide (to be retired)** - Restore with NX_ISO_TRIM_ON environment variable.

Spline (to be retired)

The legacy Spline command is to be retired in a future release of NX and is now hidden. It is recommended that you use the Studio Spline command instead. Until it is retired you have the option to bring the legacy Spline command back to NX under its new name, **Spline (to be retired)**, using the Customize command.

Thicken gash removal

The **Remove Gashes** option in the Thicken command has been renamed to **Improve Gash Topology to Enable Thickening**.
Caveats

Flattening and Forming limitation with Pattern Feature and Mirror Feature

You cannot select a Flattening and Forming feature as input to the Pattern Feature or Mirror Feature commands if the Flattening and Forming feature includes curves or points as Transformation Objects.

Expressions dialog box

- Undo is currently not well supported in the Expressions dialog box.
- Creating interpart expressions in 4GD structures may produce unexpected results.

Renew Feature

The new Renew Feature command comes with warnings in the user interface, the What’s New Guide, and the Help explaining that regenerating a feature using the latest feature version code could cause the renewed geometry to be different and thus impact dependent features and downstream objects. What is not clear is that the impact to dependent features could be severe enough to cause update failures, because they cannot support the changes introduced by the regenerated (Renewed) feature. For example, a downstream object could lose a parent if the Renewed feature creates fewer body, face or edge objects than it did with the older version of the feature’s code.

It is also possible that regeneration of a Renewed feature using the latest code could fail using the same data that worked in the older version. For example, in the past a self-intersecting object could be created, while the latest code detects and stops that object from being created, which could cause an update failure.

Features directly used as references in Pattern Feature or Mirror Feature are not supported for renewal by Renew Feature in NX 11.

Drafting

Product Notes

Importing l-deas files

If you want to import l-deas .asc or .dwg files, please be advised that starting with NX11 you must manually install l-deas ASC/DWG Importer files in addition to the NX installation. If these files are not installed the following message is shown when you try to import a .asc or .dwg file:

The l-deas ASC/DWG Importer files were not found.
Refer to the NX release notes and documentation.

The l-deas ASC/DWG Importer files are available on the GTAC site from the NX download page. They are located in the Product Updates—Drafting folder. To properly install the files, please follow the instructions contained in the l-deas ASC/DWG Importer README file.
Assemblies

Caveats

Component patterns

When the setting of your Move Component Scope customer default is Anywhere in Assembly, NX ignores this setting if the displayed part or any of its subassemblies contain any component patterns. When you move components in this situation, the Move Component command behaves as though the Move Component Scope customer default is set to Work Part Only.

When a subassembly of the displayed part contains a component pattern, inserting a motion step in your sequence that affects a member of the component pattern may cause incorrect movement of the following:

- Members of the component pattern.
- Components directly constrained to the pattern members.
- Components indirectly constrained to the pattern members.

Note

When component patterns are present only in the displayed part, the Insert Motion command works correctly.

Data Reuse

Caveats

CADENAS Library in the Reuse Library

The CADENAS Library is not yet available. It will be provided in a later release.

Sheet Metal

Caveats

Exporting multi-segment lofted flanges to Trumpf GEO format

Flat Pattern of a model that contains multi-segment lofted flanges cannot be exported to Trumpf GEO format.

Unite in Sheet Metal

If you unite bodies that consist of Sheet Metal and advanced Sheet Metal features, the united body may not support subsequent Sheet Metal operations.
Routing

Caveats

Length attribute on stock and space reservation

NX does not currently set the Length attribute on:

- Stock parts or stock components in Stock as Components mode.
- Space reservation in Space Reservation as Components mode.

Moving parts

You cannot move a routing component using the Move Part command if the customer default for the selection scope of the Move Component command is set to Anywhere in Assembly.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find Default.

Color bleeding in harness displays

If the color bleeds through in the display of harnesses, use the Refinement Factor visualization preference to correct the display. The factor you must set varies depending on the part that is open.

In the Visualization Preferences dialog box→Faceting tab→Part Settings group, use the:

- Shaded Views subgroup→Refinement Factor option to adjust the display in a shaded view.
- Advanced Visualization Views subgroup→Refinement Factor option to adjust the display in advanced studio views.

Teamcenter Classification

The Teamcenter Classification plug-in is now obsolete. You can use the out-of-the-box support for classification by setting the Teamcenter classification options in the Part Library customer defaults.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find Default.

You can use the Reuse Library for classification without setting up additional plug-ins.
Documentation Notes

Structure of a PTB file

The topic *Structure of a PTB file* erroneously states that NX uses the descriptor characteristics in the list of table columns in a PTB file to search for parts in the *Routing Reuse Search* dialog box. In reality, NX only displays the characteristics in the *Routing Reuse Search* dialog box. The switch /HIDE indicates that you do not want NX to show the characteristic in the *Routing Reuse Search* dialog box during part placement.

Note that the destination characteristics defined under specific disciplines in the APV file are used when you search for parts. This is not necessarily the same as what is displayed.

Unify Path enhancement

In previous releases, NX did not unify paths when direct mount parts or eccentric segments were a part of your selection. Parts that were placed using the *Instance Name Lookup* command and which were part of a run were ignored when you used the *Unify Path* command.

In NX 9.0.2 and later, in addition to the conditions mentioned above, NX does not unify a path that has an eccentric reducer part or any other routing part which has the *NX_BLOCK_UNIFY* attribute set to *TRUE* in the respective PTB file.

Parts which are placed using the *Instance Name Lookup* command are now ignored when you use the *Unify Path* command, even when the parts are not part of a run.
Product Notes

PLMXMLViewer configuration

The PLMXMLViewer uses the configuration saved in the registry. When you open the PLMXMLViewer, it opens according to the last configuration that was used based on what is saved in the registry.

To open the PLMXMLViewer with a different configuration, create a new configuration file, and use the Display Formats command in the View menu to save the new configuration file to the registry.

Renaming stock components in Teamcenter Integration for NX

To change the name of a stock component that is not yet saved, use the Rename Stock command.

To change the name of a stock component that is saved, use the Make Unique command or the Save As New Item command.

Retired functionality in Routing

The following are retired for NX 11.

- **Active Routing Level** Routing preference
- **Display Segment Constraints** Routing preference
- **Manage Associative Paths** command
- **By Poles** option in the Spline Path dialog box
- **Variant Conditions** command
- **Variant Configurations** command

The following Routing plug-ins are retired for NX 11.

- ROUTE_CHOOSE_PART_PLACE_PART
- ROUTE_CREATE_FABRICATION
- XML_PREIMPORT
- XML_POSTEXPORT
- SPLIT_DESCRIPTORS

Automatic fix constraint on Stock Offset Ports

In NX 9.0.2 and higher, NX adds an automatic fix constraint to every Stock Offset Port component to keep the component from moving when you connect a segment to the offset port.

This constraint is called Offset Constraint in Assembly Navigator and Constraint Navigator. If you change the name, NX reverts to the original name when the automatic fix constraint is recreated.
If you suppress the constraint, the component is free to move till you unsuppress the constraint.

If you add a new fix constraint, NX deletes the automatic fix constraint. If you delete the fix constraint that you added, NX again creates an automatic fix constraint.

You cannot move a Stock Offset Port component while editing an existing constraint using the Assembly Constraints dialog box. You can move a Stock Offset Port component while creating a new constraint using the Assembly Constraints dialog box. You can move or transform a Stock Offset Port component using the Move Component or Transform Path command if the only fix constraint on the component is the automatic fix constraint.

In case of conflicts with other constraints, NX displays a warning. In order to resolve such conflicts, you can remove or suppress the constraints that you have created or you can suppress the automatic fix constraint.

Installing standard parts to Classification in Teamcenter Engineering TC9.1

You can install standard parts to Classification in Teamcenter Engineering TC 9.1 by using the Classification Install for Part Library tool provided in the following folder:

UGII_BASE_DIR\ugroute_mech\classification_tool

Opening pre-NX 10 parts in NX 10

Opening pre-NX 10 parts might take longer when you open the part for the first time in NX 10.

Upgrade Stocks command

When using the Upgrade Stocks command on a part that uses Stock As Components and that has multiple levels of Routing assemblies, we recommend that you select the Work Part and Loaded Children Parts check box.

Ship Structure

Caveats

Stiffener/Edge Reinforcement

If you create a stiffener with three or more split knuckles, NX will get caught in a loop and you have to terminate your NX session to break out of the loop. To avoid this problem, in the Knuckles group, from the Option list, select None.

Copy Parts between Planes

The Copy Parts between Planes command does not support Extrude features that are created using the Stop at Intersection selection rule.

CAE Preparation

The Openings Less Than Diameter option in the CAE Preparation dialog box is currently not supported.
Product and Manufacturing Information (PMI)

Documentation notes

More about PMI hole callouts

Because the associated object for a PMI hole callout is the hole feature, rather than the geometry of the hole itself, the following points should be considered when creating and reusing a PMI radial or linear hole callout dimension.

- You have to select the hole feature itself when creating a PMI hole callout. Therefore, the callout must reside in the part that contains the feature. You can use PMI assembly filters if you need to display the PMI hole callout from a component in the context of an assembly.

- While most PMI annotations can be freely stacked, the PMI hole callout dimension cannot be added to a stack because doing so would break the necessary association with the hole feature. Other PMI annotations can be stacked onto a hole callout. In this case, the stacked PMI inherits an association with the hole feature faces, and not the hole feature itself.

- The **Find PMI Associated to Geometry** command only returns a PMI hole callout if the associated hole feature is selected. If you select a face from the feature, instead of the feature itself, the PMI hole callout will not be returned unless the face itself has been identified as an associated object.

- PMI hole callouts cannot be WAVE linked. This is because features are not WAVE linked, only bodies or topological entities can be WAVE linked.

- PMI hole callouts cannot be mirrored. This is because only a body can be mirrored; a feature cannot be mirrored.

- If additional model edits have affected the parameters of a hole callout, the hole callout will reflect the actual state of the hole feature, and not the original modelled state of the feature.

- Additional hole callout limitations may apply if a pattern of holes is created with a single hole feature. For example, multiple holes created from points in a single sketch.

PCB Exchange

Caveats

Flat Solid workflow

The import and export of ECAD models in their bend state only works when the board is a solid body. If the board is an assembly component this workflow does not work.

PCB Exchange for Zuken

CR5000 Data Server version 16 or earlier requires the Visual C++ 2008 Redistributable package to be installed. You can download it from the Microsoft website.
Chapter 6: CAM

Manufacturing Product Notes

Manufacturing Product Notes

The Manufacturing product notes describe product changes that are not included in the What’s New in NX documentation.
CAM Early Adopter program

Some of the new NX CAM features are available only upon request through the CAM Early Adopter Program. In order to learn more about these pre-release features, please contact GTAC. GTAC will forward your request to the appropriate development contact.
Tool path and template changes

Tool path changes

A general reminder: There are ongoing changes in the processors to fix problems, add enhancements, and improve reliability. In many cases, you may see some differences between the new path and the old path when you generate an operation from a previous release. If you rely on automatic methods, these changes should be acceptable. The end result of the new path should be comparable to, or better than, the previous path.

CAM configuration changes

- Configuration file hole_making.dat was removed.
- Key MACHINING_KNOWLEDGE was added to all configuration files.

Operation template sets

- drill.prt, machining_knowledge.prt and mill_feature.prt are obsolete and were hidden in all template sets where they occur. The operation template part files themselves are left in place for now. They can still be used as before by either browsing to their location or removing the ## hidden tag in the opt files.
- Removed entries drill.prt and machining_knowledge.prt from template.dat (used by configurations having key LIBRARY_SETU_Template).
- Added entry mill_planar.prt and mill_contour.prt to some Express configurations.
- Template sets feature_machining.opt, hole_making.opt, mill_multi-axis_hsm.opt and nc_grip.opt are not referred to in any cam configuration, but are left in place for now.

Operation template parts

- legacy_lathe.prt was removed
- Operation type manual_hole_making is obsolete and removed from hole_making.prt
- drill.prt, hole_making_mw.prt, machining_knowledge.prt and mill_feature.prt are obsolete but left in place for now.

Merging customized templates

You can merge your customized templates with the templates included in this release in the following ways:

- Start with the new default templates and apply your customizations. This is highly recommended to ensure you receive all the PR fixes.
- Re-file your customized templates in the new release, review the changes listed for the release, and implement the applicable ones in your templates. This method is not recommended, because you will not receive the PR fixes.
General changes

Paste with Reference enhancements

The Paste with Reference command now supports wave links and the new manual drilling operations.

Exporting tools as part files

Beginning in NX 10.0.1, you can create a new tool part file that contains solid bodies from a parametric tool definition. The part file contains a separate solid revolved feature for the flute, neck, shank, and holder definitions. This provides the functionality previously available by accessing the temporary tool in the Assembly Navigator.

To create the part file, in the Machine Tool view of the Operation Navigator, right-click a single parametrically defined tool and choose Object→Export Part. NX saves the tool as a single part file with the default name [tool name].prt.

Note

- This functionality is available only in native NX.
- A Modeling license is not required.
- Wave linking is not available. The solid features are based on tool parameters, and are not associative.

2D Dynamic collision display when verifying a tool path

In previous releases, rapid tool motions through the Part, Blank or IPW were displayed in the red gouge color as material removed. In the current release, the material removal from these tool motions is not displayed, so you will not see these collisions. To check for collisions, do one of the following:

- Click List after the simulation stops.
• Click **Collision Settings**. In the **Collision Settings** dialog box, select the **Pause on Collision** check box to stop the visualization when a collision occurs. This option does not work if you step through the operation.

**User Defined Operation and API Enhancements**

The **User Defined Operation** API now has the ability to:

• Use the 3D milling IPW from a previous operation as the blank.

• Write level markers to the tool path. In verify, a tool path will have the ability to display one level at a time, just like a Cavity Milling operation.

**Machine Tool changes**

The standard machine tools supplied with NX have revised postprocessors and kinematics models. Review all existing Manufacturing setups which use a standard machine tool from a release prior to NX 8. If necessary, retrieve the machine tool again.
Integrated Simulation and Verification (ISV)

Installed machines and simulation samples

For information about how to use the standard installed machines and simulation samples included with NX, see the Working_with_OOTB_MACH_Simulation_Examples.pdf file in the mach\samples\nc_simulation_samples folder of your NX installation.

Postprocessors for installed machines

The NX 11 machine library includes setups with posts created using PostConfigurator and posts created using Post Builder. The Post Builder setups include the post units in their name. For example, sim01_mill_3x_sinumerik_in.

Differences in post processing warnings

Post Process

• If you select multiple operations, but not an entire program group, NX creates a new program subgroup for the operations, and then post processes the new program group.

• If you select operations that are not in sequence, NX displays the following error message:

  Operations selected are not in consecutive order

Simulate Machine

• If you select multiple operations when the Visualization option is set to Machine Code Simulate, NX does not create a new program group, and displays the following new error messages.

  More than one object selected for Simulation
  Currently only single object selection supported

  !!! Postprocessing has been aborted !!!

When you dismiss the error messages, NX displays the Simulation Control Panel dialog box with no post processed code. You can simulate a complete program group with multiple operations because NX can post process the program group.

• If you select multiple operations when the Visualization option is set to Tool Path Simulate, NX performs the simulation because no post processing is needed.

ISV Simulation

• If the spindle speed is zero for an operation, then no material is removed from the IPW.

• Internal and external simulations now use the same geometry definitions for the part and the workpiece. You must assign the geometry to the related kinematic model components, which are classified as _PART and _WORKPIECE.

If a legacy part does not have geometry defined in the kinematics model, NX uses the geometry defined in the Operation Navigator for internal simulations.
• Tool path based simulation is not supported for mill-turn machine tools even if they are single channel single setup.

• External file simulation in Teamcenter Integration for NX uses the same file selection box as native NX.

• CSE simulation with the Sinumerik 840D controller has improved inch unit handling. When you use inch units:
  o The values inside the to_ini.ini file must also be in inches.
  o The variable values in the to_ini.ini file created by older Sinumerik posts must also be in inches. If they are not, use one of the standard posts provided with NX instead.

• For the option Show Tool Path, NX determines which machine component to attach the tool path to in the following way:
  1. In the Operation Navigator, NX finds the part geometry of the current operation.
  2. In the kinematics model, NX looks for a machine component which has the part geometry attached.
     • If the part geometry is found, NX attaches the tool path to that machine component, regardless of its classification.
     • If the part geometry is not found, NX attaches the tool path to the first machine component classified as _PART.

• For the option Show Tool Trace, NX attaches the tool trace to the first machine component classified as _PART.

• Pressing the Reset button in the Simulation Control Panel dialog box no longer updates the file content in the Program Manager. To update the subprogram or ini file content, do one of the following:
  o Close and reopen the Simulation Control Panel.

Customizing the Simulation Control Panel dialog box Speed slider behavior

If your simulation is too fast or too slow, you can change the Speed slider behavior by specifying a different Minimum Simulation Time value. For a faster simulation, you increase the Minimum Simulation Time value. For a slower simulation, decrease the Minimum Simulation Time value.

NX uses the following formula to calculate how often to display an update during simulation.

\[ \text{MST} \times 2^{(n-1)}, \text{or MST} \times 2 \text{ to the power } (n-1) \]

where:

• \( n \) is the slider setting.

• MST is the Minimum Simulation Time setting from the Manufacturing setup or the library machine tool.

The longer the time between display updates, the faster the simulation. For example, if the tool path to simulate is 100 machining seconds long, and the display updates every 1 second
of machining time, then NX must update the display 100 times for the simulation. If the display updates every 5 seconds of machining time, then NX updates the display 20 times for the same simulation, and the simulation runs faster.

**Note**

The MST value must be a multiple of the cycle time. If it is not, NX displays an alert and rounds the value to a multiple of the cycle time set on the *General* tab in the *Machine Configurator* (MCF) dialog box.

For VNCK simulations only, NX takes the cycle time directly from the booted VNCK and ignores the MCF entry.

In the following examples, the cycle time is 5 milliseconds (.005 seconds). The calculated value indicates how often NX updates the display.

<table>
<thead>
<tr>
<th>MST = .005</th>
<th>MST = .009</th>
<th>MST = .05</th>
</tr>
</thead>
<tbody>
<tr>
<td>n = 1</td>
<td>n = 1</td>
<td>n = 1</td>
</tr>
<tr>
<td>.005 * 2^n = .005 * 1</td>
<td>.01 * 2^n = .01 * 1</td>
<td>.05 * 2^n = .05 * 1</td>
</tr>
<tr>
<td>= .005 seconds</td>
<td>= .01 seconds</td>
<td>= .05 seconds</td>
</tr>
<tr>
<td>n = 2</td>
<td>n = 2</td>
<td>n = 2</td>
</tr>
<tr>
<td>.005 * 2^n = .005 * 2</td>
<td>.01 * 2^n = .01 * 2</td>
<td>.05 * 2^n = .05 * 2</td>
</tr>
<tr>
<td>= .01 seconds</td>
<td>= .02 seconds</td>
<td>= .1 seconds</td>
</tr>
<tr>
<td>n = 3</td>
<td>n = 3</td>
<td>n = 3</td>
</tr>
<tr>
<td>.005 * 2^n = .005 * 4</td>
<td>.01 * 2^n = .01 * 4</td>
<td>.05 * 2^n = .05 * 4</td>
</tr>
<tr>
<td>= .02 seconds</td>
<td>= .04 seconds</td>
<td>= .2 seconds</td>
</tr>
<tr>
<td>n = 10</td>
<td>n = 10</td>
<td>n = 10</td>
</tr>
<tr>
<td>.005 * 2^n = .005 * 512</td>
<td>.01 * 2^n = .01 * 512</td>
<td>.05 * 2^n = .05 * 512</td>
</tr>
<tr>
<td>= 2.56 seconds</td>
<td>= 5.12 seconds</td>
<td>= 25.6 seconds</td>
</tr>
</tbody>
</table>

If the MST stored with the library machine tool is different from the cycle time in the MCF, the simulation performance is now different after you retrieve the tool from the library. For example:

<table>
<thead>
<tr>
<th>Release</th>
<th>MST value in the machine tool</th>
<th>Cycle time from MCF (milliseconds)</th>
<th>MST value used for display update</th>
</tr>
</thead>
<tbody>
<tr>
<td>NX 10.0.3 MP5 and earlier</td>
<td>.01</td>
<td>5</td>
<td>0.005</td>
</tr>
<tr>
<td>NX 10.0.3 MP6 and later</td>
<td>.01</td>
<td>5</td>
<td>.01</td>
</tr>
<tr>
<td>NX 11 and later</td>
<td>.01</td>
<td>5</td>
<td>.01</td>
</tr>
</tbody>
</table>
ISV using CSE simulated controllers with Python parser

- Python parser encrypted version *.pyc files running in NX 9.x or NX 10.x will not work in NX 11.0. We recommend that you use the un-encrypted *.py files from the installed NX 11.0 release.

- The CSE Python parser is supported for Windows only.

Virtual NC Kernel (VNCK)

To run an external file machine tool simulation properly, all channels of the machine tool model that can be assigned a main program must exist in the kinematics model before you start VNCK.

Active Tool

In Verify and tool path based simulation, the active tool is always the one that is associated with the current operation in the Machine Tool view of the Operation Navigator.

In CSE simulation, you can have multiple tools active for each channel.

- You activate the tool for a channel using the AnyController command activateNextTool().

- There is one active tool per turret or spindle carrier. The total number of active tools is limited by the number of carriers.

- For material removal, NX takes every active tool in the channel of the current motion into account.

- For collision detection, including gouge check, NX only considers the last active tool in a channel.
Turning

Threading operations

When you machine conical threads with multiple starts, the engage and retract behavior is different. This is because NX now calculates the pitch distance of conical threads along the centerline of the cone. In versions prior to NX 11, NX calculated this distance parallel to the surface of the cone.
Hole machining

Feeds and Speeds - Set Machining Data

For a step drill tool, NX calculates the spindle speed based on the tip diameter.
Feature-based Machining (FBM)

Feature teaching no longer supports the *Inferred* CSYS subtype.
Manufacturing critical maintenance and retirement notices

Manufacturing Wizard Builder

The Manufacturing Wizard Builder is on critical maintenance. It is a plug-in for the Process Studio Author (PSTUDIO) application, which is no longer being developed. The 32 bit version is included in the NX installation, and there is no plan to discontinue this.

The location in the Windows start menu has changed. Choose Start→All Programs→Siemens NX 9.0→Manufacturing→Process Studio Author

There are no plans to discontinue CAM Wizards, which are xml files based on our block based UI architecture.

Point To Point planned retirement from all platforms

Point To Point is in critical maintenance. The Drill template has been hidden by default, but is still available.

The following operations and geometry objects in the Drill template are affected:

- DRILL_GEOM
- SPOT_FACING
- SPOT_DRILLING
- DRILLING
- PECK_DRILLING
- BREAKCHIP_DRILLING
- BORING
- REAMING
- COUNTERBORING
- COUNTERSINKING
- TAPPING

The hole drilling operation introduced in NX 9 should be used instead of the Point To Point module. The new method to manually drill holes will fully replace the Point To Point module over the course of the next one to two releases.

The migration of Point To Point operations is not committed at this time, but will be considered for a future release.

The new method to manually drill holes not only replaces the Point To Point module, but it also includes new capabilities such as:

- Sequential Drilling
• Deep Hole Drilling

• Back Countersinking

• Hole Chamfer Milling

• Hole Milling and Boss Milling

• Thread Milling and Boss Thread Milling

• Radial Groove Milling
Manufacturing caveats

General caveats

NX process
When you exit NX, it may close the UI without stopping the process. There is no data on how widespread this problem is.

Work Instructions
Do not include Documentation operations as the target for the following commands, as unexpected results may occur.

- Parallel Generate
- Replay
- Object Transform
- Simulate
- Gouge Check
- Verify

Shop Documentation

Each time you create Shop Documentation, NX generates facet bodies. To reduce the size of your part file, delete the facet bodies before saving it.

Command Finder: Faceting

Tilt Tool Axis

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shortest 2D distance to curve</td>
<td>Use the 3D shortest distance option.</td>
</tr>
<tr>
<td>For longer tool paths, the shortest distance calculation can become unsynchronized.</td>
<td></td>
</tr>
<tr>
<td>The tilted tool path may have non cutting moves with lifts in regions where they are not needed, and the moves can cause gouges.</td>
<td>None</td>
</tr>
</tbody>
</table>

IPW

- A Generic Motion (GMC) operation does not change the machine mode state of the IPW. Adding a Machine Control subop with a Set Modes event at the beginning of the GMC operation does not change the machine mode state of the IPW. The previous machine mode, either milling or turning, remains active.

  If the preceding operation does not have the required machine mode, you must add an operation with the required machine mode before the Generic Motion operation. For example, if the
Generic Motion operation is for turning, add a turning operation. The new operation must generate tool path, but does not need to cut material.

**Note**
This is not a limitation in ISV when you use the CSE driver. The machine state is defined by the workpiece spindle setting, which is either turning or milling.

- The IPW calculation is inconsistent:
  - For **Verify** and **Simulate**, rapid motions do not remove material.
  - When you generate the tool path for operations using the IPW, rapid motions can remove material.

This difference can result in unexpected results, for example when you use **Show 3D IPW**.
Milling caveats

Area milling drive method operations using trim boundaries

The Contact tool position option for trim boundaries trims the tool path to the tool contact of the trim boundary. However, with the Extend at Edges cutting parameters option selected, the tool is moved past the contact by the specified extend distance. In the past trim boundaries were not changed by the Extend at Edges option.

[Area milling drive method operation]→Cutting Parameters→Strategy tab→Extend Path group

Curve/Point drive method — Offset Left option

The loops caused by offsetting a concave curve or curves are not trimmed.

Rotary Floor milling

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Min. Lead Angle does not influence the tool path.</td>
<td>None</td>
</tr>
<tr>
<td>When you use sheet geometry to define a concave floor, sometimes the default material side is wrong and no tool path is produced.</td>
<td>1. In the Rotary Floor Finish Drive Method dialog box, in the Drive Geometry group, click Flip Material.  2. Generate the operation.</td>
</tr>
<tr>
<td>The cutting parameters option Roll Tool Over Edges does not affect the tool path.</td>
<td>None. This parameter will be removed.</td>
</tr>
</tbody>
</table>

Fixed-axis contouring cut area selection

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you edit a cut area created with the selection method set to Edge Bounded Region, the seed face and the bounding edges display in the selection color and are difficult to identify.</td>
<td>You can use the alternate selection color to identify the seed face and bounding edges.  • To see the seed face, click Select Bounding Edges.  • To see the bounding edges, click Select Seed Face.</td>
</tr>
</tbody>
</table>

Tip

If you still cannot see the bounding edges, increase the line width display.

Menu→Preferences→Visualization→Visualization Preferences dialog box→Line tab→Part Settings group→Show Widths→set Width Scale to Maximum
## Contour Profile variable axis profiling

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contour Profile</strong> operations only compensate for diminishing walls when the wall is in contact with the floor.</td>
<td>None</td>
</tr>
<tr>
<td>Supported cases:</td>
<td></td>
</tr>
<tr>
<td>Not supported cases:</td>
<td></td>
</tr>
<tr>
<td>Multiple offset passes that push the tool entirely above the wall height significantly increase generation time.</td>
<td>To reduce generation time, limit the number of offsets so that they do not exceed the wall height.</td>
</tr>
</tbody>
</table>
Hole machining caveats

Tapping operations

Drilling and Tapping are distinct operation subtypes. Although tapping cycles are available in the Drilling operation dialog box, we recommend that you do not use a Drilling operation combined with a tapping cycle. The tapping cycles will be removed from the Drilling operation in a future release.

In a Tapping operation, you can set feature geometry parameters, such as pitch, that output the required mom variables for tapping. If you use one of the tapping cycles in a Drilling operation:

- The operation will not contain the necessary feature geometry parameters and in-process feature volumes for tapping.
- You will have the legacy Point to Point output where the pitch is driven by feed rate.

Deep drilling reports collisions

When you use the Deep Hole Drilling operation, it currently reports a collision when the flute length is smaller than the hole depth. As a workaround, do one of the following to generate the tool path:

- Clear the Collision Check for Cutting check box.
- Define your drilling tool with a long shank section and the following parameter settings:
  
  (FL) Flute Length = (L) Length
  
  (SD) Shank Diameter < tool (D) Diameter

Deep drilling limitation for partial intersections

When you drill through a cross hole, or partial intersection, NX now crosses the intersection in a single motion using the Step Over feed rate. Partial intersections are intersections that are smaller than 3 times the tool diameter, regardless of the angle of the crossing hole.

All other intersections are considered full intersections. NX crosses full intersections in 3 motions using the First Cut, Cross Over, and Last Cut feed rates.

Back Counter Sinking operation

The collision check fails if you do not use a pre-drill operation, or when the pre-drilled hole is too small. This is because the spindle is in non-spinning mode when it moves through the hole, and non-spinning tools do not report collisions.

Sequential Drilling intersections

When you drill through an intersection that is smaller than the tool diameter, NX now crosses the intersection in a single motion, using the Step Over feed rate.

NX crosses all other intersections in 3 motions using the First Cut, Cross Over, and Last Cut feed rates.
ISV caveats

Visualize 2D Dynamic

- If blank geometry is not defined, you must click Step Forward twice before NX asks for blank geometry.

- On the Linux and Mac OS X platforms, the 2D Dynamic tab may not be active. The 8-bit PseudoColor visual graphics driver mode is not supported. As a work around, change the graphics X server settings. For example:
  NVidia Quadro and FX graphics drivers
  In the XF86Config file, in the Device section, set CIOverlay to TRUE.

Simulation

- In certain cases the reported minimum distance of a clearance violation is not the closest distance.

- Selecting a location on the tool path is now supported in ISV for both CSE-based simulation and tool path simulation. Selecting tool path segments involving cycles, such as drilling cycles, may not work in some cases.

  There are also some cases in which the selected positions of rapid motions are not displayed correctly.

- When the simulation runs in the history buffer, and the spindle speed Output Mode for an operation is set to SFM or SMM to maintain constant surface speed, the simulation behavior can be unreliable.

Virtual NC Kernel (VNCK)

- In the Machine Axis dialog box, on the Advanced tab, the WCS values are always the same as the MCS values.

- Displaying the CSE variables can influence performance. As a best practice, either limit the number of variables to approximately 5, or use the controller panel of the Sinumerik controller to check the status of NC variables.

- Do not use the Fast Reset command; it can cause an internal error. As a workaround, use the Full Reset command.

Positional ISV — Show Machine Axis Positions dialog box

- If you are running VNCK, the WCS is always the same as the MCS.

- When the setup has a multi-function machine and you use the dynamic manipulator to change the tool axis for a fixed-axis operation, NX does not update the Show Machine Axis Positions dialog box. To avoid confusion, use the Show Machine Axis Positions customer default to suppress the dialog box.


  2. In the Customer Defaults dialog box, choose Manufacturing→User Interface.
3. Click the **Dialog Boxes** tab, and in the **Visibility** group, clear the **Show Machine Axis Positions Dialog** check box.
**Post Configurator**

**Heidenhain MillTurn support**

MillTurn operations are not post processed correctly for Heidenhain controllers when you create the post processor with Post Configurator.

Workaround: None.

**Custom Message Leader inheritance status**

The inheritance status of the setting of Messages and Listing→Messages→Custom Message Leader will show User defined even if the value was never changed by the user.

Workaround: None. A workaround is not required as this does not impact post processor functionality.

**CDL**

When you create a new post processor, a CDL is not added automatically to the main DEF file. Therefore the CYCLE832 UDE and extra drilling UDEs for PTP operations are not available for Sinumerik controllers.

Workaround:

For the Sinumerik S840D, add the following line to the postprocessor's main DEF file if needed:

\$POST_LIB_CURRENT_MACH_DIR/Controller/ctrl_s840d_base.cdl

For the Sinumerik S828D, add the following line to the postprocessor's main DEF file if needed:

\$POST_LIB_CURRENT_MACH_DIR/Controller/ctrl_s828d_base.cdl

**Linux**

Post Configurator posts do not work in Linux.
Feature based machining caveats

Teach Feature Mapping, Teach Operation Sets

• If you use Teach Feature Mapping to add a new feature type, and then use Teach Operation Sets to teach NX the operations for that new feature type, NX will have an internal error. This is because Teach Operation Sets does not know the new type yet. You must restart NX after adding a new feature type.

• Teach Operation Sets does not automatically copy the conditions for identical operations.

Limitations and workarounds:

<table>
<thead>
<tr>
<th>When you</th>
<th>Teach Operation Sets does not use</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Teamcenter Integration for NX, and store the operation templates in Teamcenter</td>
<td>The correct operation subtypes</td>
<td>• Manually add the missing tool classes and operation subtypes using the Machining Knowledge Editor.</td>
</tr>
<tr>
<td>Use a library other than the native ASCII library, such as MRL or TDM</td>
<td>The tool class</td>
<td>• Replace the missing subtypes and classes. To do this:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. (Optional) Change your CAM configuration to use native operation types and the standard ASCII tool library.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Use Teach Operation Sets to teach the operations.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Use the Machining Knowledge Editor to add or optionally replace the tool classes and the operation subtypes.</td>
</tr>
</tbody>
</table>
Chapter 7: Simcenter (CAE)
New Simcenter application names and product

The computer-aided engineering (CAE) capabilities of NX are now called Simcenter, the Advanced Simulation application is now called Pre/Post, and the Motion Simulation application is now called Motion. Several other features that were previously identified as NX or LMS features are now identified as Simcenter features. For example, NX Multiphysics is now called Simcenter Multiphysics, and the LMS Motion solver is now called the Simcenter Motion Solver.

In addition to encompassing the CAE functionality within NX, Simcenter is also a stand-alone product based on NX technology. It includes the following applications:

- Gateway
- Modeling
- Assemblies
- Pre/Post
- Motion

Pre/Post

Caveats

Meshing

- The **Auto Fix Failed Elements** option in the **3D Tetrahedral Mesh** dialog box does not work for tetrahedral meshes created with the **Boundary Layer** type in the **Mesh Control** dialog box.

- The following known issues may occur when you use groups in conjunction with the **1D Connections** command:
  - In certain cases, 1D connections that reference groups do not update correctly when the content of the group changes. If this happens, no 1D connection elements will exist. If this
occurs, you can select the appropriate 1D connection in the Simulation Navigator and select Edit from the right-click menu. Then, click OK in the 1D Connection dialog box without making any changes. This forces the software to recreate the connection using the updated group or groups.

- In certain cases, 1D connections within an assembly FEM that references groups that exist in a component FEM file or subassembly FEM file are deleted when the content of the group changes. To work around this issue, create a new group in the component FEM file or in the subassembly FEM file and edit the 1D connection to reference the new group.

- You cannot currently use the Element Attach command to attach elements to a target mesh if the elements interact with the boundary of that target mesh in such a way that the target mesh is split into two or more separate regions.

Load Recipe Manager

- Only Nodal Pressure, Displacement, Velocity, and Acceleration loads are supported for use with the new Aggregated boundary conditions option. Simcenter 11 does not support the use of Aggregated boundary conditions with Force loads.

- You cannot create XY plots of Aggregated boundary conditions.

Post Processing

- For NX Nastran laminate composite results, Simcenter Post-processing takes the in-plane and inter-laminar stresses together to calculate the ply-stress invariants. Consequently, the values reported by Simcenter Post-processing are different from the values found reported in the NX Nastran results file (.f06).

- You cannot use the Result Probe command to display results on models that contain super elements.

- The Layout State commands are supported only in FEM and Simulation files in Simcenter Pre/Post.

- When you use the Envelope command to create a results envelope and export that envelope to a universal (UNV) file, the software does not write information on solid laminate elements to the UNV file.

- With the Color Bar Plot, you can plot up to 200 functions. To change this maximum function limit, set the following environment variable: UGII_MAX_RECORD_COUNT_OF_COLORBAR.

Materials

In NX 7.5, the default material library changed from an NX-specific .dat format to a MatML XML format. Beginning with Simcenter 11, the legacy material library .dat format will no longer be supported.

Abaqus environment

- You can define only the following types of constraints at the solution level in Simcenter 11:
  - Fixed Constraint (*BOUNDARY keyword)
o Fixed Translation Constraint (*BOUNDARY keyword)

o Fixed Rotation Constraint (*BOUNDARY keyword)

o Initial Conditions (*INITIAL CONDITIONS, TYPE=VELOCITY)

If your input file contains any other type of constraints defined at the solution level, the software does not import them. It issues a warning message that indicates that the constraints were not imported.

- The software does not correctly import Abaqus assembly models (models defined with the *ASSEMBLY/*PART/*INSTANCE keywords) that contain DCOUP2D or DCOUP3D elements.

- If your input file contains equations that have more than four terms, the software does not import the equation.

- Pre/Post does not currently support the *KINEMATIC COUPLING keyword for import into the Coupled Thermal-Structural environment. The *KINEMATIC COUPLING command corresponds to the Automatic Coupling command in the Abaqus environment.

ANSYS environment

- The Default Cyclic Symmetry Cylindrical CSYS options in the New FEM and New FEM and Simulation dialog boxes are currently unsupported when you import ANSYS input files into the software and export ANSYS input files from the software.

- Although the software can export component pressures that are defined in all coordinate system types, it can import only component pressures that are defined in the Cartesian coordinate system.

NX Nastran and MSC Nastran environments

For NX Nastran Acoustics and Vibro-Acoustics analyses, if your solution includes an Enforced Motion load on any structural dependent nodes, such as those from RBE2 elements, these DOFs will appear in both the SPC set (s-set) and the RBE dependent DOF set (m-set), causing the solver to abort. If your intent is to provide enforced structural motions as input to a weakly coupled vibro-acoustic solution, you can specify PARAM,SPCSTR,YES in the input file to avoid this error and instruct the solver not to compute the already provided structural vibrations.

LS-DYNA environment

- The Default Cyclic Symmetry Cylindrical CSYS options in the New FEM and New FEM and Simulation dialog boxes are currently unsupported when you import LS-DYNA input files into the software and export LS-DYNA input files from the software.

- Material *MAT_116 (*MAT_COMPOSITE_LAYUP) is not supported for import.

- Material *MAT_054-055 (*MAT_ENHANCED_COMPOSITE_DAMAGE) is now supported for import and export. However, during import, Simcenter incorrectly maps *MAT_054-055 in the user interface to *MAT_COMPOSITE_LAYUP (the default).

- You can now define the stress-strain curve for LS-DYNA materials. Simcenter exports this data as the LS-DYNA keyword *MAT_PIECEWISE_LINEAR_PLASTICITY or as *MAT_024. However:
Temperature-dependent stress-strain data is currently unsupported. Although you can define it in Simcenter, only the first temperature value is exported to your LS-DYNA input file.

The *MAT PIECEWISE_LINEAR_PLASTICITY keyword is not yet supported for import. It will be supported in a future release.

Samcef environment

- When you use a zone-based workflow to define a laminate, the software does not correctly export the laminate draping data when several Laminate or Solid Laminate physical property tables are shared by multiple mesh collectors.

- Except for the mass value, the Solid Properties command does not yet calculate the properties of 1D elements.

- The following issues occur when you post-process Samcef results:
  - Relative rotation results are incorrect (zero values are shown).
  - Component 33 of the middle stress and middle strain results on 2D elements are incorrect.
  - When shell results are available on only 2 of the 3 available locations (top, middle and bottom), the results in the shell are incorrect.
  - You cannot display stress and strain contours on selected beam cross section.
  - The damage tensors are not properly displayed if the model contains both metallic and composite elements.

- Any output requests that you defined in a model in NX 10 are not available when you open the same model in Simcenter 11.

- The Solution Monitor does not parse any data if you use a separate Samcef solver suite with the language not set to English.

- Simcenter groups that contains Rigid Link or Mean 1D connections are incorrectly written in the Samcef input file.

- The following issues occur when you import a Samcef model:
  - The software fails to import a model when some of the names of its entities (for instance, the name of a material) contain special characters (such as ampersand) or accented characters.

  - The software fails to import a Samcef .SEL group if one item in the group is missing in the model. This occurs, for instance, when the user defines groups and then glues parts in Samcef with the .COLL command.

  - The software fails to import a Samcef .SEL group of elements when this group contains some .MCE elements that are not imported.

- When importing Samcef Surface-To-Surface .MCT contact conditions:
  - Two equivalent Node-To_Surface Contact simulation objects are created instead of the classical Surface-To-Surface one.
The Samcef \textit{OPT} coupled/uncoupled option is ignored.

The software fails to import time-dependent \textit{.CLM PRESS} pressure loads.

The software fails to import nodal \textit{.CLM ACC} accelerations.

The software fails to import the \textbf{Stress-Strain (H)} law if this law depends on both temperature and strain.

- Samcef parallel computing Distributed Memory Parallel (DMP) mode or Shared Memory Parallel (SMP) mode does not work with the Samcef solvers that are included in Simcenter.

**Acoustics BEM environment**

- In a weakly coupled analysis, you must define displacements at all structural nodes. In this release, you cannot run an analysis with displacements defined at only a subset of the structural nodes.

- On Linux machines, the solver may not find boundary conditions at some frequencies. Simcenter Pre/Post writes the analysis frequencies in an ASCII file using 6 digits. The solver must retrieve boundary conditions at those frequencies from its binary database. The tolerance for this operation is lower on Linux machines (1.0E-06) than on Windows machines (1.0E-04). Because of the lower tolerance value on Linux, there is a fair probability that when the frequency is not an integer, the solver may not find any boundary condition within the tolerance. When this occurs, the solver either computes zero results or, in a weakly coupled analysis, issues a fatal error and exits.

To work around this issue, you can increase the tolerance by setting \texttt{ENVIRONMENT DBS\_TOLERANCE = 1.0E-04} in the \texttt{SYSNOISE.STP} file that is located in the Simcenter 11 installation in the \texttt{SIMULATION/acoustics/sysnoise/res} directory.

**Simcenter Thermal/Flow, Space Systems Thermal, and Electronic Systems Cooling**

- Surface tension is not supported in immiscible fluid mixtures.

**Durability**

Durability only uses table fields for S-N and E-N curves.

**Stress and Vibration Wizards**

You must have the Simcenter Pre/Post product (\texttt{nx\_master fem license feature}) to run the Stress Wizard or Vibration Wizard.

**Motion**

**Caveats**

The following issues currently exist in Simcenter Motion.
Simcenter Motion Solver

- Virtual.Lab models with stiction ON may produce different results with the Simcenter Motion Solver.

- The displacement, velocity, and acceleration channels of a 3D contact element are not computed by the Simcenter Motion Solver. They are always reported as 0.

- For displacement, velocity, and acceleration of either a point-on-curve or curve-on-curve element, the Simcenter Motion Solver computes only the absolute values on X, Y, and Z. If you try to plot other results, an error message appears: The requested result is not supported with the Simcenter Motion Solver.

Simcenter Motion Solver mechatronics co-simulation

- The order of inputs and outputs in the Motion interface co-simulation block (as seen from LMS Imagine.Lab Amesim) does not follow the order of inputs and outputs as they are set in the Mechatronics dialog box within the Simcenter Motion application. Proper association between existing Amesim components and a newly imported Motion interface must be done by name.

- In the Mechatronics dialog box, if you modify the Scale or Offset value for an existing port, the software does not automatically recompute any existing solutions.

- The suppression status of output ports generated by a mechatronics interface is not propagated to the referencing control outputs and drivers.

- Due to certain file extension restrictions, you cannot use a motion simulation that includes a mechatronics interface or control input or output with Teamcenter Integration.

Tires and roads

- You cannot currently select a road object in the graphics window. You must select the road object from the Motion Navigator.

- If you are using the FTire, you might encounter slightly different results when you solve the mechanism a second time, even if you have not made any changes to the Motion model. This occurs when the FTire solver fails to reset a particular variable during a static analysis. This issue should be fixed in the 2016-2 release of the FTire software. In the interim, you might be able to avoid this situation by repositioning or reconfiguring the road so that any variations in height occur later in the simulation (such as 20 cm further forward).

- The Simcenter Motion Solver supports 95 results variables. However, the new CDTire libraries export up to 180 results variables. Because of this, if you solve a mechanism when all of the check boxes are selected on the Selected Results Variables tab in the CDTire Property dialog box, the solution could fail. You can avoid this error by clearing the Energy Loss Due to Friction check box.

- Pressure data in the friction surface data file used by the Basic and Motorcycle tire elements is always considered in N/mm². Any pressure unit specified in the friction surface data file is ignored.
• Due to certain file extension restrictions, you cannot use a motion simulation that includes tire or road objects with Teamcenter Integration.

**LMS Virtual.Lab to Simcenter Motion migration**

• Joints defined with a principal axis of motion other than the Z-axis are not correctly imported from Virtual.Lab Motion into Simcenter Motion. You must correct the axis selection in the Simcenter Motion model.

• If the center of gravity (CG) for a Virtual.Lab Motion body is defined based on a CATPart axis system, then the CG information is not correctly imported into the Simcenter Motion model.

• Virtual.Lab bodies that reference CATProduct assemblies which include non-identity transformations between the assembled CATParts and the parent CATProduct are not imported correctly into Simcenter Motion.
Documentation notes

Flexible link support

The *Rigid bodies (links)* topic in the Motion help incorrectly states that the flexible link feature requires the RecurDyn solver. You can create flexible links using the RecurDyn solver and the Simcenter Motion Solver.

3D contacts

The documentation does not state that 3D contacts for Articulation and Spreadsheet Run solutions are not supported with the Simcenter Motion Solver.

MATLAB Simulink co-simulation

Several help topics indicate that you must select the **MATLAB Co-simulation** check box in the *Environment* dialog box in order to solve the mechanism when performing co-simulation with MATLAB Simulink. This check box only validates that the corresponding license is available from the license server or file. Whether or not this check box is selected, the Simcenter Motion Solver checks out the corresponding license when you solve the mechanism. If the license is not available, the solve fails.

Tires

Several help topics indicate that you must select the appropriate check box in the **Vehicle** group in the *Environment* dialog box in order to solve the mechanism when the corresponding tire type is active. Whether or not any of those check boxes are selected, the Simcenter Motion Solver checks out the corresponding license when you solve the mechanism. If the license is not available, the solve fails.
Chapter 8: Design Simulation
Caveats

Report Writer

Design Simulation does not support report generation through application-provided sample templates and commands. Fully user-defined report customizations are supported.
Chapter 9: Inspection and validation

Check-Mate and Requirements Validation

Caveats

Validation rules

Validation rules do not yet recognize unset part attributes.

Using Teamcenter as the issue site for NX Issue Management

When you use NX Issue Management, you can specify Teamcenter as the issue site only when Teamcenter Issue Manager is deployed via Teamcenter Environment Manager at the server side. NX displays an error message if it cannot connect to Teamcenter Issue Manager. For more information, refer to the Teamcenter Environment Manager Help.

CMM Inspection Programming

CMM release notes

VALISYS critical maintenance and retirement notice

The VALISYS application is in critical maintenance, and becomes unsupported July 21, 2016. The NX CMM Inspection Programming application should be used instead of VALISYS Programming and CMM Inspection Execution should be used instead of NX-Inspect.
Caveats

Renaming or deleting the SENSORS group

In the Inspection Navigator, do not delete or rename the SENSORS group as this may cause machine simulations within the Inspection Path dialog box to fail.
Chapter 10: Tooling Design

Weld Assistant

Documentation notes

Weld Point Wizard

When you create weld points using the Weld Point Wizard, when you set Method to Existing Point, clear the Automatic Update check box to ensure that the newly created linked faces are deleted.
Chapter 11: Data translation
Product Notes

Updates in the default tessUG.config JT configuration file

The doSectionViews configuration option which is used to process non-lightweight PMI section views (also known as heavyweight section views) is removed from the default tessUG.config file shipped with NX11. This option is now renamed as LegacyHeavyweightSectionViews. If your existing NX part or assembly contains section views created using PMI tab→Section View command in Pre-NX11 versions and you want to translate these section views to a JT file, you need to add LegacyHeavyweightSectionViews option in your tessUG.config configuration file and set it to true.

CATIA V5 translator product notes

You can now:

- Import CATIA V5-6R2015 files to NX.
- Export NX files to CATIA V5 R14 or R19 files.
Caveats

Internationalization caveat

File import or export by the following translators may not work if you set the NX temporary directory 
\texttt{UGII\_TMP\_DIR} to a folder containing non-locale characters.

- DXF/DWG
- IGES
- STEP
- 2D Exchange (export only)

\textbf{NX to JT translator caveats}

\textbf{NX to JT translator caveat for the Windows operating system}

\textbf{NX to JT translator does not support new IRAY+ materials, textures, and lights defined on objects in an NX part. When translator encounters such parts during processing, it writes the base color of the object in the JT file and adds a warning message in the log file.}

If you are translating pre-NX11 parts with material, texture, and light applied on it and you want to get the texture or light information into the JT file, We recommend you to invoke NX in Author2 (non-IRAY+) rendering mode and then translate the parts to a JT file. This recommendation is applicable for JT creation from interactive NX session as well as command line application \texttt{ugtopv}. Contact GTAC to get more information on how to invoke NX in Author2 (non-IRAY+) rendering mode.

\textbf{JT configuration option advancedMaterials in the JT configuration file is not applicable for the new IRAY+ materials, texture, and lights.}

By default, NX 11 uses new IRAY+ renderer and the Material, Light and Texture option is not available in the \textbf{JT Configuration} and the \textbf{Export JT} dialog boxes.

\begin{tcolorbox}[colback=gray!10]
\textbf{Note}

If you invoke NX in Author2 (non-IRAY+) rendering mode then these options will be available in the \textbf{JT Configuration} and the \textbf{Export JT} dialog boxes.
\end{tcolorbox}

\textbf{NX to JT translator caveat for the Linux operating system}

During JT creation on Linux operating system, you may experience issues like freeze of translation process for some parts. This is not a generic issue and only occurs with specific part files. If you encounter any such issue with your part files, please contact GTAC and log an IR.

\textbf{DXF/DWG translator caveats}

- If you export a locked 2D component, the latest component definition is exported to the DXF/DWG file.

You can avoid this by creating a new component definition. To do this, right-click the 2D component and choose \textbf{Make Unique}. 
• 2D components with color override are exported as per the colors set in the component definition.

DXF/DWG — Dimension export caveats
These caveats are applicable when you export a file using the 3D option in the AutoCAD DXF/DWG Export Wizard dialog box.

• Dimensions associated with external references are exported as non-associative dimensions to the DXF/DWG file.

• NX Radius dimensions associated with ellipse or spline object are translated as AutoCAD block reference.

• The dimension associated between NX sheet object and View port object may be translated as overridden text of AutoCAD dimension.

• Narrow dimensions are exported as non-associative dimensions to the DXF/DWG file.

• Perpendicular, Chamfer, and Thickness dimensions are exported as block reference to the DXF/DWG file.

• Angular dimensions created with vector option are exported as block reference to the DXF/DWG file.

• Dimension with fits tolerance having fit tolerance style other than Fit Symbol is exported as block reference in AutoCAD.

• Dimension text location may not match with NX for the dimensions created with oriented text.

• Dimension line breaks and foreshortening symbols are not supported when dimension is exported as group or block.

• If a dimension is exported as a grouped geometry, then the line-breaks and the foreshortening symbols are not exported in the DXF/DWG output.

• If a dimension text is on the extended dimension line, the exported dimension has to be updated to view any foreshortening symbols on it.

DXF/DWG — MText import caveats
You cannot import:

• MText paragraph tabs to NX.

• Euro symbol (created using %%128 in MText) to NX.

DXF/DWG — Architecture data import caveats

• You can not import:
  o View dependent data
  o Texture data
  o Corner windows
Wall cleanups

Body modifiers on staircase

- Associativity defined between the architecture objects is not maintained in NX. For example, door on wall will not move along if wall is moved.

DXF/DWG — Solids import caveats

You cannot import:

- Material, color, and transparency applied on solids in the DXF/DWG file.
- Solids data at location outside the NX supported bounding box.

2D Exchange caveats

- Object attributes with title longer than 50 characters or string value longer than 132 characters are not exported to 2D parts.

2D Exchange – Dimension export caveats

These caveats are applicable for both, when you export a file using the NX Part file option in the 2D Exchange Options dialog box or when you export a file using the 2D option in the AutoCAD DXF/DWG Export Wizard dialog box.

Following dimensions are exported with the Override Dimension Text:

- Feature Parameter Dimensions
- True Length Dimensions
- Dimensions in scaled view and output set to Modeling (applies only when you export a file using the NX Part file option in the 2D Exchange Options dialog box)
- Dimensions associated to:
  - Drafting Intersection point
  - Offset center point
  - Section line (in scaled view)
- The dimensions where associated object type changes in the flattened part. For example, circle projected as line.

Following Data will be exported as grouped geometry in the 2D part file and as a block in the DXF or DWG file.

- Linear and Radial callouts
- Retained dimensions
- Component level dimensions and PMI dimensions
- Inherited ordinate PMI dimensions
• Dual dimension in scaled views and output set to **Modeling**.

• Dimension with hole and shaft tolerance in scaled views and output set to **Modeling**.

• Dimensions associated with:
  o Blanked objects
  o 3D and Symmetric centerlines
  o Faces
  o Two object intersection (applies to ordinate dimension only)
  o Target Points

• Dimension created in plane other than view plane.

**STEP translator caveats**

• When you export or save NX data to a .stpx file, STEP translator does not export nested external references.

**CATIA V5 translator caveats**

• When you use the NX Data Exchange external interface to export an assembly on Linux 64 or Mac operating system, the output file field may indicate an extension of .CATPart, whereas the translator will accurately produce an output file with the expected .CATProduct extension.

• You cannot translate CATIA V5 R7 and earlier version of files.

• You cannot translate standard and user defined attributes.

• You cannot translate NX files to CATIA V5 without saving the changes to the NX file. When you select the **Displayed Part** and **Entire Part** options and export a modified NX assembly file to CATIA V5, in the displayed message box you can click **Yes** to save the part and translate it or click **No** to cancel the translation. The **Continue** option of the message box to translate the part without saving it does not work properly.

• You cannot Import CATIA V5 assemblies (*.catproduct) in NX managed mode. If you try to do so, NX displays an error message and reverts you to the previous dialog box.

• Color is supported on a per face basis.

• You can only import CATIA V5 “Lines and Curves” into NX using default “Linetype” and “Thickness” values.

• You cannot export NX parts with file name containing international characters.
Chapter 12: 4th Generation Design
Product Notes

4G Easy

Beginning with the Teamcenter 11.2.2 release, the 4gd_populate_utility is replaced by the 4g_easy utility. You can use the new 4G Easy tool to interact with the utility. See the Teamcenter 4th Generation Design help for more information.
Chapter 13: Mechatronics Concept Designer
Product Notes

PLCopen XML export for STEP 7

Mechatronics Concept Designer can export the sequence of operation in the standardized XML format PLCopen XML. PLCopen XML can be imported into STEP 7 5.5 SP 2 Hotfix 4 and above. If you need to update your current STEP 7 installation you can find information about the latest service packs and hotfixes at the following:

English:
https://support.industry.siemens.com/cs/products?dtp=Download&mfn=ps&pnid=14342&lc=en-WW
Chapter 14: Line Designer
Product notes

Template files

The standard part files delivered with Line Designer must be imported into the Teamcenter database to ensure that they are available in the New Item dialog box. If this step is not performed, the New Item dialog box displays only blank templates.

A setup script for installing Line Designer templates in Teamcenter is included with NX:

%UGII_ROOT_DIR%\LINE_DESIGNER\templates\tcin_linedesigner_template_setup.bat

For information about how to use the script, see Installing File New templates in the NX help at the following location:

Home→
    Teamcenter Integration for NX→
    System Setup/Administration→
    Server Setup/Administration→
    Installing/creating/modifying templates→
    Installing File New templates

Platform support

Line Designer is currently supported only on Windows platform.

Data migration

Due to changes in the connectors, a change in the data format of equipment was required. In NX 11, all equipment that uses connectors from previous releases will be migrated to the new NX 11 format when you open the equipment. To reduce the time required to open equipment that will be migrated, we recommend that you refile all library equipment that uses connectors in the new NX 11 format.

For more details, see Refiling in the NX help.

4GD support

Use of Line Designer with 4GD capabilities requires a Teamcenter Plant extension for fourth Generation. This extension is included in Manufacturing Additions package to Teamcenter installation (ManufacturingAdditions 1.1). You can get the Manufacturing for 4GD package from the download section of the Siemens PLM Software download server.

From the left side list of the product categories, choose Teamcenter and Teamcenter Rapid Start. The Windows package is located at:

Teamcenter and Teamcenter Rapid Start→
    Full Products→
    Windows (64-bit)→
    Integrations and Solutions→
    ManufacturingAdditions→
    1.1→
        TC10.x_ManufacturingAdditions_1.1_wntx64.zip
        TC11.x_ManufacturingAdditions_1.1_wntx64.zip

The Linux package is located at:
Teamcenter and Teamcenter Rapid Start →
Full Products →
Linux (64-bit) →
Integrations and Solutions →
ManufacturingAdditions →
1.1 →
TC10.x_ManufacturingAdditions_1.1_lnx64.zip
TC11.x_ManufacturingAdditions_1.1_lnx64.zip

Instructions for applying the Manufacturing Plant extensions are included in the package zip file (Plant Extensions - Deployment Guide.pdf).

Factory resource samples

Installation of the sample factory resources, conveyors, and robots from the manufacturing resource sample library to Teamcenter is highly recommended.

Factory Resources
Factory Conveyors
Factory Robots

Instructions for installing the samples are located in the following section of the Teamcenter HTML documentation:

Home →
Installing →
Installation on Windows Servers Guide →
Adding Features →
Manufacturing →
Installing and configuring the Manufacturing Resource Library

Manufacturing Resource Library version compatibility

Line Designer in the NX release 11 is certified for use with factory resources from the Manufacturing Resource Library (MRL) 3.1.5 or later for Teamcenter release 10.1.5 or TC11.2.2.

Upgrading smart objects to the current NX version

NX will automatically upgrade the older version of smart objects from previous NX releases to the new version when they are opened and saved in new version of NX.
Documentation notes

Note the following about the Line Designer documentation:

• Although Line Designer can work with either BVR or 4GD data structures, typically the documentation describes the 4GD procedures.

• The Home→Line Designer→Line Designer project administration section in the NX 11 Help should be ignored for now. It will be updated in NX 11.0.1 help.
Caveats

Fast Placement
Currently, **Fast Placement** works only among components that are under a plant structure (below a production unit or below a workarea). **Fast Placement** does not work when editing an assembly that is not in the plant structure.

Editing smart component sketches
While editing sketches of smart components, the 3D object is visible. You can still edit the sketch values by dragging the sketch nodes.

Configured components in the Plant Navigator
Configured components from the plant structure appear as loaded components in the **Plant Navigator**.

Editing reusable component
While editing some PTS components such as Jibcrane, hidden datum planes, axes, and coordinate systems are displayed.

PMI
While inserting PTS components with PMI into a plant layout with active PMI assembly filters, the PMI note won't be visible.
Chapter 15: Programming Tools

The Release Notes for Programming Tools are available only with the installed NX Help documentation. After you install the documentation, you can access the information from any of the following locations.

• From the Start menu on your system, choose:
  o All Programs→Siemens NX 11.0→Documentation→NX Release Notes.
  o All Programs→Siemens NX 11.0→Release Information→NX Release Notes.

• Within NX, choose:
  o File tab→Help→Release Notes.
  o Menu→Help→Release Notes.
Siemens Industry Software

Headquarters
Granite Park One
5800 Granite Parkway
Suite 600
Plano, TX 75024
USA
+1 972 987 3000

Americas
Granite Park One
5800 Granite Parkway
Suite 600
Plano, TX 75024
USA
+1 314 264 8499

Europe
Stephenson House
Sir William Siemens Square
Frimley, Camberley
Surrey, GU16 8QD
+44 (0) 1276 413200

Asia-Pacific
Suites 4301-4302, 43/F
AIA Kowloon Tower, Landmark East
100 How Ming Street
Kwun Tong, Kowloon
Hong Kong
+852 2230 3308

About Siemens PLM Software

Siemens PLM Software, a business unit of the Siemens Industry Automation Division, is a leading global provider of product lifecycle management (PLM) software and services with 7 million licensed seats and 71,000 customers worldwide. Headquartered in Plano, Texas, Siemens PLM Software works collaboratively with companies to deliver open solutions that help them turn more ideas into successful products. For more information on Siemens PLM Software products and services, visit www.siemens.com/plm.

© 2016 Siemens Product Lifecycle Management Software Inc. Siemens and the Siemens logo are registered trademarks of Siemens AG. D-Cubed, Femap, Geolus, GO PLM, I-deas, Insight, JT, NX, Parasolid, Solid Edge, Teamcenter, Tecnomatix and Velocity Series are trademarks or registered trademarks of Siemens Product Lifecycle Management Software Inc. or its subsidiaries in the United States and in other countries. All other trademarks, registered trademarks or service marks belong to their respective holders.